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File Menu

The File menu includes commands that enable you to open,import and export files, delete a 
database, and to setup database parameters.

For more information, select the File menu command name.

New
Open
Import
Export
Delete
Setup
Printer Setup
Exit



File New Command

Use this feature to create a new PMS database.    When you select "New",    a screen 
marked "Open File Screen" will appear.    You may select an existing directory by double-clicking 
on one of the drives in the menu, and selecting    the desired directory.    Then select the "OK" 
button.    The new database file will be created.

You also have the choice of making a new directory in this window.    Select the "Make a 
New Directory" box.    Next type the directory name in "New Directory " box at the top of the 
screen.    Next select the desired drive from the list shown.    You may scroll through your entire 
system; both drives and directories.    If you double-click on a drive designation, PMS will return 
all the directories in that drive.    In this way, you may be sure you do not duplicate a directory 
that    has been created.    When the desired new directory name shows properly following    
"Directory:"    select the "OK" button, and the new directory will be created.

At any time during this process, you may elect to cancel the process by selecting the 
"Cancel" button.    Do not attempt to create a new PMS file in a directory that already has a PMS 
database file in it; otherwise, PMS would assume that the data in that directory belongs to the 
new file.        An error message will return if you attempt to do so.    Each PMS database must 
reside in a separate directory.    (There is no problem with using the same drive.)

PMS will give you access to this newly created database file at any time you desire; along
with all the databases you have created.    The new file will be a duplicate of the file you are in 
when you create the new one.    The only difference will be that there is no information in the new
file.    If you desire to change the labels for checkboxes, etc., simply run the setup procedures for 
the new file.    Until you give a name to the new database file, PMS will call it "No System Name". 



File Open Command

When you select this feature, a screen will appear that will give you a list of all the 
existing databases you have created to-date.    To select a different database to work on, select 
the name of the desired database and select the "OK" button.    The database you are working on 
will be closed, with all the changes you have made saved; and the new database will be opened 
and appear on your screen.                              



File Import Command

Choose this feature to import database information from another source.    In order to 
import data, the fields must exactly match the fields of PMS.  This is useful for transferring bulk 
names and addresses into PMS.    For more information about Import, see the "Technical 
Reference" section.



File Export Command

Choose this feature to export database information from PMS's files to other files or for 
use with word processing merge features.    For more information on Export, see the "Technical 
Reference" section.



File Delete Command

Delete will remove an entire database from your computer.    You will be presented with a list of 
databases existing on the computer and asked to select the database to delete.    Selecting "OK" 
will remove all PMS    related database files from the selected directory.



File Setup Command

Select this menu item to set up a new database file created with the "New" feature.    Here
you will name the new file, choose the People and Event category names, etc..    



Setup - System Parameters

System Title:    Type in the name for this database.    This is the name that will appear in 
the top bar of your main PMS screen.    It is also the name of the database which will appear for 
selection    when you are using the "Open" function.

Comm Port:  Type in the Comm Port that will be used for the AutoDial feature.    This will 
tell PMS where to find the phone line.    The form for your input should be:    COM1

Administrator:    Type in the name of the person in charge of Administration of the 
database.

Home Event:    Type in the title you would like automatically placed in the Event Title Box
each time you call someone's home (example;    "Phone Log - Called placed to home").    This title 
is optional for setup procedures, and even if you specify a title, you will be able to change it once
the program is running.

Business Event:    Type in the title you would like automatically placed in the Event 
Title Box each time you call someone's business (example;    "Phone Log - Called placed to

Business").    This title is optional for setup procedures, and even if you specify a title, you will be 
able to change it once the program is running.

Fax Event:    Type in the title you would like automatically placed in the Event Title Box 
each time you call someone's fax number (example;    "Phone Log - Called placed to fax 
number").    This title is optional for setup procedures, and even if you specify a title, you will be 
able to change it once the program is running.



Setup - Event Checkboxes

Use this feature during setup, to type in names of the different categories you anticipate 
will adequately describe the normal events for your database (examples might be "Received 
Letter"; "Sent Memo"; "Phone Call Received"; "Phone Contact Made"; etc. )    Using this process, 
you are "customizing" PMS to your own needs.    Give consideration to these category names, as 
you will be able to search by these categories, and reports available will also use the category 
names.



Setup - People Checkboxes

Use this feature during setup, to type in names of the different categories you anticipate 
will adequately describe the normal people classifications for people in your database (examples 
might be "Volunteer", "Contributor", "Relative", "Client", etc. )    Using this process, you are 
"customizing" PMS to your own needs.    Give consideration to these category names, as you will 
be able to search by these categories, and reports available will also use the category names.



File Printer Setup Command

Choose "Printer Setup", and the screen will show you the printer(s) available for use 
through WINDOWS TM.    If more printers appear than you plan to use PMS with, you do not have 
to remove them.    Highlight the printer you plan to use, and select to "OK" button.    There are 
some options on the "Setup" button, but your printer should be already configured through 
WINDOWS TM.    If you have any problems with printer interface, please see the "Technical 
Reference " section.



File Exit Command

Choose this feature to "Exit" from your PMS database program.    The "Close" feature in 
the WINDOWS TM    system menu in the upper left corner of the main PMS screen provides 
the same function.



Edit Menu

The Edit menu includes commands that enable you to move text to and from the clipboard, 
to delete text, and to undo a previous editing operation.    These operations are only 
effective for the comments field for an individual.    PMS uses a program internal clipboard for
copying address records and event records.    You may, however, use the shift-insert and 
shift-delete key combinations to transfer text via the Windows clipboard anywhere in the 
program.

For more information, select the Edit menu command name.

Clear Deletes text without moving it to the clipboard.
Copy Copies text to the clipboard.
Cut Deletes text and moves it to the clipboard.
Paste Moves text from the clipboard to the edit window.
Undo Cancels a previous operation.



Maintenance Menu

The Maintenance menu includes commands that enable you to Add, Update or Delete People
and Events

For more information, select the Maintenance menu command name.

People Maintenance Menu Maintains People Records.
Event Maintenance Menu Maintains Event Records.



Event Maintenance Menu

This section is used to add, delete, or update information for events in your database.    It 
is necessary to first select the person with whom the event is associated.     If you are using a    
mouse, it    will be easier to use the "Add", "Update", and "Delete"    buttons that appear 
immediately to the right of    the block that displays    the current list of events.    This location is in
the lower right hand corner of the PMS screen.

Add Event Adds Event Records.
Update Event Updates Event Records.
Delete Event Deletes Event Records.



Add Event

This function is used to add events for any person    to your database.    First select the 
person to whose file you wish to add the event.      To    start this function, select the "Add" button 
that appears in the lower right corner of the main PMS screen.    or select "Maintenance", then 
"Event Maintenance", then "Add Event"    from the menu bar.    When you select "Add Event" ,    a 
screen will appear showing the selected person's name at the top.    The information    entered 
here will be the basis of PMS's ability to respond to your later inquiries, so take the time to enter 
as complete information as you can.    . 

You will notice a "date and time" box at the top of the screen.    This should be today's 
date, and the current time.    Each time you add an event, PMS will record both the time and 
date, so you may refer to it at any later time.    If you wish to record the event as occurring at 
some other date or time, you may change either the date, the time, or both.    To change the date,
select the "month" box, and use the scrolling device to increase or decrease the month #.      
Next, select the "day" box, and again, scroll up or down till you see the desired date.    Continue 
from box to box for both the date, and time , if desired.    The same effect can be achieved by 
tabbing from box to box, and entering the desired date or time from your computer keyboard.    
Changing from "AM" to "PM" is accomplished by either of these methods. 

The long, rectangular box that runs across your screen, immediately below the date & 
time box,    is used to record the "Event Title".    When you are on the main PMS screen, this is the
information you will see when the person is selected on the record list.    Also, the date and time 
that the event occurred, or was recorded, will be shown.    Briefly describe the event, in terms that
will be clear to you when only the title appears .

Beneath the "Event Title" box, is another blank box.    In this "Event Comments" section, 
you may enter any message, note, or information you desire.    The message can be up to 
approximately 1000 characters.    Each person in your database may have multiple events; the 
titles, dates, and times, will be shown on PMS's main screen, in reverse chronological order 
(most recent events first), when the person's name is selected or highlighted in the people list.    
Both "Event Titles"    and "Event Comments"    are available to be printed out on various reports.



Update Event

This function will allow you to change the information about any event    in your database. 
Only the information associated with the Event functions is available for change; information 
associated with people may be changed using the "People Update" function.    To start the update 
function, select the "Update" button that appears to the right of the "Event Titles" box, in the 
lower right hand corner of the main PMS screen,    or select "Maintenance", then "Event 
Maintenance", then "Update Event " from the menu bar.    The use of the "Update" function 
requires that you select the name, then the event,    that is going to be updated;    if you do not 
select an event,    PMS will remind you by an error message on your screen.    If the wrong record 
presents itself for updating, this is because you had an event selected, or highlighted, on the 
main screen    (select "Cancel", and try again).

When updating, you will use a similar screen to the "Add Event" screen.    In fact, it's the 
same, except it will show the name of the person selected at the top of the screen.    All the 
people information you entered, or even information you did not have at the time of original 
entry, can be added or changed at this time.    If you make any changes, including the Event 
Category selections, the database will be changed accordingly.    If you select the "Cancel" button,
no changes will be made; the record remains as it was in the database.    When you select the 
"OK" button, the changes are made to the database, and PMS returns you to its main screen.

A shortcut to "Update" an event when using a mouse is to double-click on the 
event.    The "Update" screen will appear.

You may also use the "Update" function to check on any information in the "event" portion
of your database.    Select "Cancel" after you are finished reviewing information, and no changes 
will be effected in your database.



Delete Event

This function is used to permanently remove events from your database.    Be cautious 
with the use of the delete function, as the information deleted may not be    retrievable.      To 
delete an event from your database, first select the name from the record list on your main PMS 
screen.    Then, select the Event you wish to delete.    Then select the "Delete" button in the lower 
right of your main PMS screen,    or select "Maintenance", then "Event Maintenance", then " 
Delete Event".    The event selected will be removed completely from the database.    .    If you 
make an attempt to use the "delete" function without first selecting the event to delete, you will 
get an error notice reminding you to do so.    However, if you have highlighted    an event prior to 
selecting the "delete" function, that event will be deleted.    



People Maintenance Menu

The Maintenance menu includes commands that enable you to Add, Update or Delete People
and Events

This section is used to add, delete, or update information for people in your database.    If 
you are using a    mouse, it    will be easier to use the "Add", "Update", and "Delete"    buttons 
that appear immediately above the block that displays    the current list of people.    This 
location is directly below the menu bar, and in the upper left hand corner of the PMS screen.

For more information, select the Maintenance menu command name.

Add Person Adds People Records.
Update Person Maintains People Records.
Delete Person Deletes People Records.



AddPerson

Selecting ADD PERSON from this menu will present you with a dialog box to enter 
information for a new individual.    This is the same as selecting the ADD button just under 
the menu bar..
This funtion is used to add each person    to your database.    When you select "Add Person",   
the "Add Person" screen will appear.    The information    entered here will be the basis of 
PMS's ability to respond to your later inquiries, so take the time to enter as complete 
information as you can.    Notice that you have the ability to    enter a prefix, a middle initial, 
and a suffix, or title.    Make your decision early as to how complete a record your use 
requires.    There is a "Company Name" box for you to use.    If the new person to your 
database is associated with a company or organization, be sure to enter this information;    
one of the functions of PMS will allow you to display and search your database from this 
criteria.    After you have added the new person's address, you have the option to enter a 
2nd address as well.    To do this, select the    "Add 2nd Address" button, and fill in the 2nd 
address when the new screen appears.    It is possible to toggle between the primary and 
secondary addresses at will, using the two buttons provided for second addresses.    
Company addresses may be primary or secondary; it all depends how you plan to use them. 
PMS suggests you make the address to which you would send information by mail the 
primary one.    You can always tell at a glance which address is being displayed; again by the
selections allowed on the two address buttons.    Although the Fax Phone is a handy part of 
the PMS database, the autodial feature of this version does not have a valid use for it.    You 
may find that some persons in your database have a third phone number you would like to 
have on record; record it in place of the Fax #.    The final entry for adding    a member to 
your database is the checkbox section.    During your setup procedure, you decided what 
"people categories" you will be using.    Select the categories    for the    person being added, 
by clicking the appropriate box with your mouse cursor.    An "X" will apear in each category 
box selected.    You may choose one or more; either as positive or negative, depending on 
the information you have about your person as you enter the new name.    If you do not have
the need for a full 20 categories in your database, you may use empty category boxes later 
to select "special" or "temporary" subset lists (See Helpful Hints Section).    Finally, you have 
the option of selecting "Cancel" or "OK", using the buttons in the lower left corner of the 
"Add Person " screen.    If you select "Cancel", the information you have entered will not be 
changed or added to your database.    When you select "OK",    the information showing on 
your "Add Person" screen will become part of your database.    Therefore, it is important NOT 
to use this function for updating information;    entering    partial information could replace 
more complete information in your database (use the "Update" function to change or add 
information for anyone already entered in your database).



Update Person

This function will allow you to change the information about any person in your database. 
Only the information associated with the People functions is available for change; information 
associated with events may be changed using the "Event Update" function.    To start the update 
function, select the "Update" button that appears directly above the people list on your main 
PMS screen, or select "Maintenance", then "People Maintenance", then "Update Person" from the
menu bar.    The use of the "Update" function requires that you select the name that is going to be
updated;    if you do not select a name, PMS will remind you by an error message on your screen. 
If the wrong record presents itself for updating, this is because you had a name selected, or 
highlighted, on the people list (select "Cancel", and try again).

When updating, you will use a similar screen to the "Add Person" screen.    In fact, it's the 
same, except it will show the name of the person selected at the top of the screen.    All the 
people information you entered, or even information you did not have at the time of original 
entry, can be added or changed at this time.    If you make any changes, including the People 
Category selections, the database will be changed accordingly.    If you select the "Cancel" button,
no changes will be made; the record remains as it was in the database.    When you select the 
"OK" button, the changes are made to the database, and PMS returns you to its main screen.

A shortcut to "Update" a person when using a mouse is to double-click on the person's 
name.    The "Update" screen will appear.

You may also use the "Update" function to check on any information in the "people" 
portion of your database.    Select "Cancel" after you are finished reviewing information, and no 
changes will be effected in your database.



Delete Person

This function is used to permanently remove persons from your database.    Be cautious 
with the use of the delete function, as the information deleted may not be retrievable.      To delete
a person from your database, first select the name from the record list on your main PMS screen.
Then select the "Delete" button above the people list, or select "Maintenance", then "People 
Maintenance", then " Delete Person".    The person selected will be removed completely from the 
database, and the number of records will be reduced by one; reflecting the change made.    If you 
make an attempt to use the "delete" function without first selecting the person to delete, you will 
get an error notice reminding you to do so.    However, if you have highlighted one of the names 
on your record list, that person will be considered selected, and will be deleted.



Subset List Menu

When you create a "Subset List", you are limiting certain information which would 
normally appear on your screen, or appear in reports produced.    The advantages of such 
limitation make PMS a "friendly" information manager, as it eliminates the need to view many 
file folders of information, making scrolling through names and events much easier and quicker.    
It also gives you the opportunity to produce reports for specified dates or date periods, and for 
limited persons or events.    

A unique feature of PMS helps you keep track of the criteria used for determining each 
subset list.    When you enter into a subset list ("working database"), a pull down menu 
("Options") appears on the top right of your main PMS screen;    just under the menu bar.    It 
shows the basic subset list sub-menu item;    listing    the criteria used for specific selection on the
pull down portion of the menu.    

When you create a Subset List, only the persons who conform to your specially selected 
criteria appear on the people list on the screen.    The number of records that are available 
through your limiting criteria will be specificied, in the "# of # Records Selected"    box in the 
center of PMS's main screen,    just below the menu bar. ( When    you are not working with a 
Subset List, the message "Full DATABASE" will appear immediately below this box. )    Only people
with classifications or events that conform to the limited criteria are displayed.    You are creating 
a special "working database" , which will be limited until you tell PMS to restore the Full 
Database.    Information in your database is not limited during this process; only the amount of 
information available for    and viewing and printing is affected.

When you are using a "working database", created by using the Subset List function, the 
message "Subset" will appear below the "# of Records Selected" box, and this box will tell you 
how many persons in your full database conform to your limiting criteria.    When there are more 
people or events than will fit in the "people list" box, or the "event list" box, a scroll bar will 
appear at the right hand side of the appropriate box.    This will enable you to access the 
additional names or events.

When you select a subset based on Event criteria, PMS will find the people that have 
those events;    it will not find the events.    You may emphasize the events by which you selected 
the subset list by choosing "Show Only Selected Events" under the "Options" menu.

Set Date Limits
People - Any Check
People - All Checks
Events - Any Check
Events - All Checks
Restore Full List



Subset - Set Date Limits
This option will allow you to limit the amount of data you have in your "working 

database", by restricting the available Event information to a specific date, or a specific date 
range.    Rather than view and search your entire database, with Events over periods of months or
years, you can "tell" PMS you only wish to access the information flow for the last two months; or
the last two weeks; or just today's Events.    Even if a person in your database has no events in 
the specified time period, his name will continue to be part of your "working database".    
However, for those persons who have older Events, the non-specified events need not appear on 
the screen.    (See "Options" menu).

To set date limits, select "Set Date Limits" from the menu bar.    A screen will pop up that 
says "Set Event Search Dates-Currently Off(Set)".    If you have been working with a specified date
limitation, the message will read "Currently Set"; if not, it will read "Currently Off".    The date bar 
is operated in the same manner as previously described.    Tab from field to field, and either type 
the information in, or scroll to the desired dates.    First specify the "Start Date", then specify the 
"End Date".    If you make the start date and end date the same, you will limit yourself to one 
day's activities.    This is especially useful for monitoring or reporting of daily activities.    A 
message "Date Set" will appear on the top of your screen to remind you that you are working 
with the limited database showing.

Clear
You need not change the date range to end the limits to your "working database".    By 

selecting the "Clear" button, the search range dates will be toggled to read "Currently Off".    
Regardless of the date range shown in the "Set Event Search Dates" box, PMS will ignore them.    
You may return to this box at any time and reactivate the same search range by selecting the 
"Set" button.

Set
Selecting the "Set" button informs PMS that you are about to set a search date range.    

You may now tab from field to field, entering the specified date range through your keyboard, or 
select with your mouse and scroll to the desired dates.    You may be more comfortable with 
changing the date(s), and then choosing "Set".

Cancel
Selecting the "Cancel" button will return you to the PMS main screen, and make no 

changes to the search date range.    If the selection is "Currently Off", it will remain off.    It the 
selection is "Currently On", it will remain on.    This is useful if you would like to check whether 
your range is "On" or "Off" without making any changes.

OK
When you have specified your new date range, select the "OK" button.    This will tell PMS 

you have completed your changes, and to accept them.    Your selection will be "On" or "Off", 
whichever the box shows before selecting "OK".    You will be returned to the PMS main screen.



Subset - People - Any Check
When you select this function, a screen will appear entitled "Subset List for People - Match

any Check".    You will see the People Categories you have chosen for your database, but now 
there will be a "NO" box for each category.    You may check one or more categories, and PMS will
limit your subset list to those that match any check.    You may select a "NO" in one or more 
categories, and PMS will include persons who are "not" in that category also.    If you select three 
categories, a person who meets only one of the search criteria WILL be included in your subset 
list.

Checkboxes
Tab from field to field, entering your selection by using your spacebar, or select any box 

with your mouse, and toggle the field with your left mouse button.    Successfully selected fields 
will show an "X" in the field.    To unselect a field, select again.

OK
When you are sure you have selected all the desired criteria, select the "OK" button.    You 

will be returned to the PMS main screen.

Cancel
Regardless of any changes made (or not made), selecting the "Cancel" button will return 

you to the PMS main screen without recording any changes in the subset list.    



Subset - People - All Checks
When you select this function, a screen will appear entitled "Subset List for People - Match

All Checks".    You will see the People Categories you have chosen for your database, but now 
there will be a "NO" box for each category.    You may check one or more categories, and PMS will
limit your subset list to those that match ALL checks.    You may select a "NO" in one or more 
categories, and PMS will include persons who are "not" in that category also.    If you select three 
categories, a person who meets only one of the search criteria WILL NOT be included in your 
subset list.    Only persons who match each and every criteria specified, either positive or 
negative, will be included in your subset list.    If your search range appears too narrow, try again 
after removing some of the search criteria.

Checkboxes
Tab from field to field, entering your selection by using your spacebar, or select any box 

with your mouse, and toggle the field with your left mouse button.    Successfully selected fields 
will show an "X" in the field.    To unselect a field, select again.

OK
When you are sure you have selected all the desired criteria, select the "OK" button.    You 

will be returned to the PMS main screen.

Cancel
Regardless of any changes made (or not made), selecting the "Cancel" button will return 

you to the PMS main screen without recording any changes in the subset list. 



Subset - Events - Any Check
When you select this function, a screen will appear entitled "Subset List for Events - Match

any Check".    You will see the Event Categories you have chosen for your database, but now there
will be a "NO" box for each category.    You may check one or more categories, and PMS will limit 
your subset list to those that match any check.    You may select a "NO" in one or more 
categories, and PMS will include persons who are "not" in that category also.    If you select three 
categories, a person with events    that meets only one of the search criteria WILL be included in 
your subset list.

Checkboxes
Tab from field to field, entering your selection by using your spacebar, or select any box 

with your mouse, and toggle the field with your left mouse button.    Successfully selected fields 
will show an "X" in the field.    To unselect a field, select again.

OK
When you are sure you have selected all the desired criteria, select the "OK" button.    You 

will be returned to the PMS main screen.

Cancel
Regardless of any changes made (or not made), selecting the "Cancel" button will return 

you to the PMS main screen without recording any changes in the subset list. 



Subset - Events - All Checks
When you select this function, a screen will appear entitled "Subset List for Events - Match

All Checks".    You will see the Event Categories you have chosen for your database, but now there
will be a "NO" box for each category.    You may check one or more categories, and PMS will limit 
your subset list to those persons that have events that match ALL checks.    You may select a 
"NO" in one or more categories, and PMS will include persons who are "not" in that category 
also.    If you select three categories, a person who meets only one of the search criteria WILL NOT
be included in your subset list.    Only persons who match each and every criteria specified, either
positive or negative, will be included in your subset list.    If your search range appears too 
narrow, try again after removing some of the search criteria.

Checkboxes
Tab from field to field, entering your selection by using your spacebar, or select any box 

with your mouse, and toggle the field with your left mouse button.    Successfully selected fields 
will show an "X" in the field.    To unselect a field, select again.

OK
When you are sure you have selected all the desired criteria, select the "OK" button.    You 

will be returned to the PMS main screen.

Cancel
Regardless of any changes made (or not made), selecting the "Cancel" button will return 

you to the PMS main screen without recording any changes in the subset list.    



Subset - Restore Full List
When you select "Restore Full List", you will stay in the PMS main screen, and all the 

records will be returned to the available database; the screen will again display the maximum 
data.    The "# of # Records Selected" box will show all records selected, and the remark "Full 
DATABASE" will appear immediately under that box.    



AutoDial Menu

In order to enjoy the maximum benefit from this function, your system should be 
connected to a modem, and a phone set should be readily available by your computer terminal.    
Using this feature, you may dial a person's home, business, or fax phone; entering a record of the
time and date of the event (call) if you desire to do so.    Should you choose to "create an event" 
by the call, you may accept the event title specified in your setup, or re-title the event, and even 
record your comments (through your keyboard) up to 1000 characters.    For similar calls to many 
persons in your database, you may use the "Edit" function to copy, and then paste the same 
information to each person called.    

When you select    one of the "AutoDial" features, a pop up screen will appear that says 
"Dialing", and PMS will dial the number selected.    It is not necessary for you to enter any phone 
numbers; PMS will dial the number according to your selection.    When the connection to the 
called party is made, select the "OK" button, and pick up your phone.    If the call does not go 
through, or the line is busy, select    the "OK" button to terminate the call.

Dial Home
Dial Business
Dial Fax
Dial Home - Create Event
Dial Business - Create Event
Dial Fax - Create Event



 Dial Home
Select this feature, and PMS will automatically dial the phone number you entered as 

"Home" phone number when you added this person to your database.



 Dial Business
Select this feature, and PMS will automatically dial the phone number you entered as 

"Business" phone number when you added this person to your database.



 Dial Fax
Select this feature, and PMS will automatically dial the phone number you entered as 

"Fax" phone number when you added this person to your database.



 Dial Home - Create Event
Select this feature to have PMS dial the home number of the desired party, and record 

your pre-selected title for the event on an "Add Message" screen.
The    screen will appear showing the selected person's name at the top.    The information 

entered here will be the basis of PMS's ability to respond to your later inquiries, so take the time 
to enter as complete information as you can.    . 

You will notice a "date and time" box at the top of the screen.    This should be today's 
date, and the current time.      PMS will record both the time and date, so you may refer to it at 
any later time.    If you wish to record the event as occurring at some other date or time, you may 
change either the date, the time, or both.    To change the date, select the "month" box, and use 
the scrolling device to increase or decrease the month #.      Next, select the "day" box, and 
again, scroll up or down till you see the desired date.    Continue from box to box for both the 
date, and time if desired.    The same effect can be achieved by tabbing from box to box, and 
entering the desired date or time from your computer keyboard.    Changing from "AM" to "PM" is 
accomplished by either of these methods. 

The long, rectangular box that runs across your screen, immediately below the date & 
time box,    is used by PMS to display (and record) the message title you selected during setup 
procedures.        When you are on the main PMS screen, this is the information you will see when 
the person is selected on the people list.    Also, the date and time that the event occurred, or was
recorded, will be shown.    You may modify the event title if you desire to do so;    put your cursor 
in the title box and edit with your keyboard.

Beneath the "Event Title" box, is a blank box.    In this "Event Comments" section, you may
enter any message, note, or information you desire.    The message can be up to approximately 
1000 characters.    Each person in your database may have multiple events; the titles, dates, and 
times, will be shown on PMS's main screen, in reverse chronological order (most recent events 
first), when the person's name is selected or highlighted in the people list.    Both "Event Titles"    
and "Event Comments"    are available to be printed out on various reports.

The last section of the "Create An    Event" function is for you to select one or more Event 
Categories; bearing names that you selected during the setup function.    You will be able to 
search by these categories of events at any time after they are selected.    Tab from box to box,    
recording your selection(s) by hitting your spacebar, or select any box with your mouse cursor 
and click on it.    An "X" will appear in each selected category.    To "unselect" any category, select 
it again; the toggle action will remove the "X", and the selection.

 Finally, you have the option of selecting "Cancel" or "OK", using the buttons in the upper 
right corner of the "Create An Event" screen.    If you select "Cancel", the information you have 
entered will not be changed or added to your database.    When you select "OK",    the information
showing on your "Add Event" screen will become part of your database.    (Use the "Update" 
function to change or add event information for anyone already entered in your database).



 Dial Business - Create Event
Select this feature to have PMS dial the business number of the desired party, and record

your pre-selected title for the event on an "Add Message" screen.
The    screen will appear showing the selected person's name at the top.    The information 

entered here will be the basis of PMS's ability to respond to your later inquiries, so take the time 
to enter as complete information as you can.    . 

You will notice a "date and time" box at the top of the screen.    This should be today's 
date, and the current time.     PMS will record both the time and date, so you may refer to it at 
any later time.    If you wish to record the event as occurring at some other date or time, you may 
change either the date, the time, or both.    To change the date, select the "month" box, and use 
the scrolling device to increase or decrease the month #.      Next, select the "day" box, and 
again, scroll up or down till you see the desired date.    Continue from box to box for both the 
date, and time if desired.    The same effect can be achieved by tabbing from box to box, and 
entering the desired date or time from your computer keyboard.    Changing from "AM" to "PM" is 
accomplished by either of these methods. 

The long, rectangular box that runs across your screen, immediately below the date & 
time box,    is used by PMS to display (and record) the message title you selected during setup 
procedures.        When you are on the main PMS screen, this is the information you will see when 
the person is selected on the people list.    Also, the date and time that the event occurred, or was
recorded, will be shown.    You may modify the event title if you desire to do so;    put your cursor 
in the title box and edit with your keyboard.

Beneath the "Event Title" box, is a blank box.    In this "Event Comments" section, you may
enter any message, note, or information you desire.    The message can be up to approximately 
1000 characters.    Each person in your database may have multiple events; the titles, dates, and 
times, will be shown on PMS's main screen, in reverse chronological order (most recent events 
first), when the person's name is selected or highlighted in the people list.    Both "Event Titles"    
and "Event Comments"    are available to be printed out on various reports.

The last section of the "Create An    Event" function is for you to select one or more Event 
Categories; bearing names that you selected during the setup function.    You will be able to 
search by these categories of events at any time after they are selected.    Tab from box to box,    
recording your selection(s) by hitting your spacebar, or select any box with your mouse cursor 
and click on it.    An "X" will appear in each selected category.    To "unselect" any category, select 
it again; the toggle action will remove the "X", and the selection.

 Finally, you have the option of selecting "Cancel" or "OK", using the buttons in the upper 
right corner of the "Create An Event" screen.    If you select "Cancel", the information you have 
entered will not be changed or added to your database.    When you select "OK",    the information
showing on your "Add Event" screen will become part of your database.    (Use the "Update" 
function to change or add event information for anyone already entered in your database).



 Dial Fax - Create Event
Select this feature to have PMS dial the fax number of the desired party, and record your 

pre-selected title for the event on an "Add Message" screen.
The    screen will appear showing the selected person's name at the top.    The information 

entered here will be the basis of PMS's ability to respond to your later inquiries, so take the time 
to enter as complete information as you can.    . 

You will notice a "date and time" box at the top of the screen.    This should be today's 
date, and the current time.      PMS will record both the time and date, so you may refer to it at 
any later time.    If you wish to record the event as occurring at some other date or time, you may 
change either the date, the time, or both.    To change the date, select the "month" box, and use 
the scrolling device to increase or decrease the month #.      Next, select the "day" box, and 
again, scroll up or down till you see the desired date.    Continue from box to box for both the 
date, and time if desired.    The same effect can be achieved by tabbing from box to box, and 
entering the desired date or time from your computer keyboard.    Changing from "AM" to "PM" is 
accomplished by either of these methods. 

The long, rectangular box that runs across your screen, immediately below the date & 
time box,    is used by PMS to display (and record) the message title you selected during setup 
procedures.        When you are on the main PMS screen, this is the information you will see when 
the person is selected on the people list.    Also, the date and time that the event occurred, or was
recorded, will be shown.    You may modify the event title if you desire to do so;    put your cursor 
in the title box and edit with your keyboard.

Beneath the "Event Title" box, is a blank box.    In this "Event Comments" section, you may
enter any message, note, or information you desire.    The message can be up to approximately 
1000 characters.    Each person in your database may have multiple events; the titles, dates, and 
times, will be shown on PMS's main screen, in reverse chronological order (most recent events 
first), when the person's name is selected or highlighted in the people list.    Both "Event Titles"    
and "Event Comments"    are available to be printed out on various reports.

The last section of the "Create An    Event" function is for you to select one or more Event 
Categories; bearing names that you selected during the setup function.    You will be able to 
search by these categories of events at any time after they are selected.    Tab from box to box,    
recording your selection(s) by hitting your spacebar, or select any box with your mouse cursor 
and click on it.    An "X" will appear in each selected category.    To "unselect" any category, select 
it again; the toggle action will remove the "X", and the selection.

 Finally, you have the option of selecting "Cancel" or "OK", using the buttons in the upper 
right corner of the "Create An Event" screen.    If you select "Cancel", the information you have 
entered will not be changed or added to your database.    When you select "OK",    the information
showing on your "Add Event" screen will become part of your database.    (Use the "Update" 
function to change or add event information for anyone already entered in your database).



Options Menu

The Options Menu allows you to toggle your display of people to a display of company 
names    or Zip codes and to limit the events display to only selected events based on 
selection criteria.    There also also options for displaying amounts and customizing reports.    
A checkmark next to an option indicates that the option is currently in effect.    All checkmark
selection states are saved at program exit and are restored when you start the program 
again.

For more information, select the Options menu command name.

Display Company
Display Zip Codes
Display Amounts
Customize Reports
Show Only Selected Events



Display Company

By selecting this feature, you "toggle" PMS into a mode that will present the Company 
name (entered during the Add Person function) as primary;    Company names will appear on the 
main screen , instead of individuals' names.        If any person in the database does not have a    
Company name, that person's name will appear as primary on the screen.    To enter the    
"Display Company " feature, tab to highlight it and press your "Enter" key, or select with your 
mouse cursor and press the left mouse button.    Use this feature for browsing or searching 
through records using the Company name, instead of the person's name.    PMS will resort the 
database so that your display is still in alphabetical order.    A checkmark will appear to the left of 
the "Display Company" option while it is selected.    To avoid toggling the "Display Company" 
feature, tab back out of that menu option, or point your mouse cursor outside the menu option.    
Although the presentation of Company names should make it obvious that this feature in 
enabled, you may also select the "Options" menu, and look to see if there is a checkmark to the 
left of the feature.    When the checkmark appears, the feature is enabled.

When Display Company is enabled,    any reports produced will be in Company sort order and
the Use Company Name checkbox in the Customize Reports screen will be checked.



Display Zip Codes
By selecting this feature, you "toggle" PMS into a mode that will present the Zip Code 

and person's last name in the People Box on the main screen , instead of individuals' names.        
To enter the    "Display Zip Codes " feature, tab to highlight it and press your "Enter" key, or select
with your mouse cursor and press the left mouse button.    Use this feature for browsing or 
searching through records using the Zip Code, instead of the person's name.    PMS will resort the
database so that your display is still in numerical/alphabetical order.    A checkmark will appear to 
the left of the "Display Zip Codes" option while it is selected.    To avoid toggling the "Display Zip 
Codes" feature, tab back out of that menu option, or point your mouse cursor outside the menu 
option.    Although the presentation of Zip Codes should make it obvious that this feature in 
enabled, you may also select the "Options" menu, and look to see if there is a checkmark to the 
left of the feature.    When the checkmark appears, the feature is enabled.

When Display Zip Codes is enabled,    any reports produced will be in Zip Code sort order.    
This will make label printing print labels in Zip Code Order. 



Display Amounts

When this feature is enabled,    four new fields will be displayed on the main screen.     
The word Amount maybe replaced by using the FILE SETUP SYSTEM PARAMETERS menu 
option.

Total Amount - People List

This value represents the summation of individual amounts from the Person records 
for the people in the list.    If the entire database is selected, then this amount would reflect 
the summation of all Person records.

Total Amount - Event List

This value represents the summation of individual amounts from the Event records 
for the selected Person.    If Show Selected Events option is turned off,    This amount should 
equal the Amount - Selected Person.

Amount - Selected Person

This value is the amount value from the selected person's Person record and should 
represent a summation of all events for this person.

Amount - Selected Event

This value is the amount value from the selected Event record.



Customize Reports

Selecting this option will enable report customization.    When this option is on and 
you select a report to print, you will be presented with a screen that will allow you to select 
how the report headers will look and what data should appear on the reports.    Default 
values are presented based on the report selected and the options currently in effect.    You 
may make changes and press OK to produce the report, or you can save your changes and 
they will become the new default for printing the report (even if Customize Reports option is 
off).    This will allow you to customize the reports once and forget about the headers in the 
future.



Show Only Selected Events

This feature will allow you to show only the events that are subset list criteria on your 
main PMS    screen.    You will not be able to browse or update events that are not part of the 
selected event criteria.    "Show Only Selected Events" is selected by tabbing to this feature and 
pressing your Enter key, or by placing your mouse cursor on it and pressing the left mouse 
button.    You may select the "Options" menu at any time, to see if this option in enabled, or not.    
To unselect, simply select again.    Because it may not be so obvious that this feature is enabled, a
message stating "Selected Events" will appear just below the "# of # Records Selected" box near 
the top of your screen.    When the "Selected Events"    message appears, the feature is enabled, 
and complete event records will not show on your screen.





Reports Menu

PMS offers nine basic report styles, with numerous variations possible.    Since most of the
reports offer the ability to be produced from subset lists (in addition to the complete PMS 
database),    the list of available reports is actually endless.    In addition, there are three label 
formats for you to choose from.    Reports are designed to get much of the data in your database 
to "hard copy", for the ease of viewing by others.    As you gain experience in developing subset 
lists, with these reports in mind, you will learn to ask questions about the people information in 
your PMS database that you may have never thought of before.    The reports are geared to 
providing top-level "management"    decision-making information.

Each report will bear the "System Title" ( the name you gave your database during setup),
the date the report was produced, and the time of day the report was produced.    Since your 
database is always changing, it is important to know when the report was produced.

While each report is printing, you have the option of cancelling the individual report, by 
selecting the "Cancel Printing" option that will appear in the center of your screen.

Detail Reports
Summary Reports
Labels



Detail Reports

The first group of reports allow to you to print detailed information.    These reports are 
designed to give as complete information as possible to persons not able to view the data on the 
computer.    They also assemble data not easily discernable from viewing a database file.    You will
find that the questions you ask when you decide to produce a report will govern the quality of the
actual report.    The structure of some of the reports may actually give you some creative ideas 
about how to think about    the information in your database.

Detail Reports will automatically start a new page for each person.    If the report calls for 
more than one page for an individual, PMS will still start the next report on a fresh page.    For a 
look at the report forms, see "SAMPLE REPORTS " section in the    "APPENDIX".

Detail History (Person)
Detail History (Subset)
Activity for Date Range
Last Activity



Detail History (Person)

This report will print out almost everything    your PMS database knows about the 
individual.    It includes the individuals' name, his company (if any), the primary address, all phone
numbers, all People Categories selected for the individual, personal comments recorded, and 
copies of each event involving the individual.    Each event will show type of event (including 
Event Category, if you selected one), a title for the event, time & date event occurred, and 
comments you recorded about the event.    If the individual has many events, this will be a long 
report;    the kind a reader would want if he needed all the information that was available.    
Secondary addresses will not be printed in this report, unless you "toggle" the addresses to make
them primary.    The report header will read "Detail History Report".

Example



Activity for Date Range

This report will produce all the details for a selected subset of names in your PMS 
database, for a specific date, or for activity between two dates (a date range).    This report is a 
compilation of "Individual History Reports", for a subset of people selected by your criteria; but 
only for a specific date or specific date range.    By setting the beginning date to be the same as 
the ending date, you may produce a daily report.    The report header will read "Activity Detail 
between <date> and <date>".

Example



Example Activity for Date Range Report 

                                              QUICK START COMPANY                     Sat 10/26/91
10:06

Detail History Report

Mr.    Andrew A. Adams Pres.                          Home Phone: 1-(589) 555-1212
ADAMS APPLES                                                              Bus. Phone: 1-(589) 655-
9853
1034 West Covina Ave.                                            Fax    Phone: None
San Francisco, CA    65897

 People Categories:                     Prospective client              Retail Firm

President of Adams Apples - a firm employing approx 25 persons.    Principal activity is 
wholesale fruit distribution.

                                                            --------------------
07/09/91 03:05 PM      Called to discuss over services.
          Event Categories:                Estimate prepared
He asked some specific questions about how our market studies are done, how long they 
take, and what the cost might be.    He will call back later.    Sent estimate for preliminary 
market study.
                                                            --------------------
06/18/91 11:50 AM      Open file.    Prospect.
          Event Categories:                File opened
Met Mr. Adams on the golf course.    He may call for more info on our company.



Last Activity

This report will show only the last event for each person you select in your PMS database.
The report will show you the "pulse" of activity of your database.    None of the detail for the 
individual is left out; only multiple events, if they exist.    The report header will read "Last 
Activity Detail Report".

Example



Example Last Activity Report

                                                QUICK START COMPANY                      Sat 10/26/91
10:10

Last Activity Detail Report

Mrs. Alicia A. Andrews CEO                              Home Phone: 1-301-992-6532
ATTITUDE ADJUSTERS, INC.                                          Bus. Phone: 1-202-321-9587
5548 W. Third Avenue                                                  Fax    Phone: 1-202-663-3451
Washington, DC    25894

 People Categories:                     Client-Full billing            Service Business
          (Open)

Alicia is a friend of Sue Downs, who referred her to us for cash flow
projections.    She is experiencing too much month at the end of her budget, and may need 
to find some ways to borrow operating capital until her business takes off.

                                                            --------------------
11/22/91 11:00 AM      Payment received.
          Event Categories:



Detail History (Subset)

This report is a continuous printing of "Detail History (Person)" reports for each person in 
the subset selected by your criteria.    Failure to first select a subset will give you a report for each
person in your PMS database (if you have a large database, this could take some time).    The 
report header will read "Detail History Report".

Example



Example Detail History Report

                                                QUICK START COMPANY                      Sat 10/26/91
10:05

Detail History Report

Mrs. Alicia A. Andrews CEO                           Home Phone: 1-301-992-6532
ATTITUDE ADJUSTERS, INC.                                        Bus. Phone: 1-202-321-9587
5548 W. Third Avenue                                                Fax    Phone: 1-202-663-3451
Washington, DC    25894

 People Categories:                      Client-Full billing            Service Business

Alicia is a friend of Sue Downs, who referred her to us for cash flow
projections.    She is experiencing too much month at the end of her budget, and may need 
to find some ways to borrow operating capital until her business takes off.

                                                            --------------------
11/22/91 11:00 AM      Payment received.
          Event Categories:

                                                            --------------------
11/15/91 09:00 AM      Settlement on Line of Credit.
          Event Categories:                Project Completed
Will pay in seven days.
                                                            --------------------
10/30/91 02:50 PM      Loan approved.
          Event Categories:                Loan approved
First Union said "yes".    Interest of 13% over 5 years with 2 points. 
Min.repayment 5% of outstanding balance.    Settlement on 11/15/91.
                                                            --------------------
10/21/91 08:49 PM      Loan submitted.
          Event Categories:                Loan submitted
To: First Union, BankAmerica, & Bolton Pension Fund
                                                            --------------------
10/18/91 02:45 PM      Loan package received.
          Event Categories:                Loan package done

                                                            --------------------
10/12/91 08:46 PM      Conference re: cash flows.    Signed for line of credit 
          Event Categories:                Contract signed                    Projected Cash Flow
          Current Cash Flows
Appears to warrant borrowing of a $45,000 line of credit.
                                                            --------------------
10/02/91 11:45 AM      Open file. Needs cash flow studies.
          Event Categories:                File opened
Sent brochure.



Summary Reports

Summary Reports offer less detail than the reports listed above; they are geared to print 
out only the information you really need, and do not show personal comments about people or 
events.

Activity Summary
Last Activity
Activity for Date Range
People in Subset
Database Statistics



Activity Summary

This report shows the criteria used to select the subset, each activity on record for those 
on the subset list, the time & date for each event, and the title you gave to each event.    The 
report header will read "Activity Summary".

Example



Example:    Activity Summary

                                                QUICK START COMPANY                      Sat 10/26/91
10:11

Activity Summary
Selection by Person - Any of the following categories

Lawyer 

Mr. Clinton C. Chase Esq.
09/14/91 03:40 PM      Came to office to meet with John
08/16/91 04:30 PM      Lunch with John.
06/03/91 03:50 PM      Conference with Mr. Chase.
05/10/91 02:00 PM      Open file.    Resume received. Local

Mr. Edward E. Edgerly Esq.
08/18/91 10:00 AM      Open file.    Received resume. PA. (Pittsburgh)

Mr. Michael M. Moonstruck Esq.
10/23/91 04:10 PM      Stopped by our office to introduce himself.
10/18/91 10:07 PM      Open file.    Legal/settlements.    Local.

Mr. Peter P. Phillips Esq.
06/22/91 11:00 AM      Open file.    Business card on file.    Miami

Mr. Vance V. Vanderhood Esq.
05/26/91 01:00 PM      Open file.    Business card on file. Local



Last Activity

This report    shows the criteria used to select the subset, and only the last event for each 
person in the subset list; including the time & date the last event occurred, and the title you gave
the event.    The report header will read "Last Activity Summary".

Example



Example:    Last Activity (Summary)

                                                QUICK START COMPANY                     Sat 10/26/91
10:12

Last Activity Summary
Selection by Person - Any of the following categories

CPA 

Mr. Carl C. Chamberlin 
08/03/91 08:50 AM      Open file.    Received resume. Georgia.

Mr. Clinton C. Chase Esq.
09/14/91 03:40 PM      Came to office to meet with John

Mr. Felix F. Farnsworth Esq.
07/18/91 10:00 AM      Open file.    Received resume.    Alabama



Activity for Date Range

This report allows you to select a subset, and then show all events on a particular 
date, or between two dates (a date range).    It shows the selection criteria, the individuals' 
names, date & time of events, and the titles you gave the events.    If you do not choose to 
create a subset, this report will function for a "daily report", or "monthly summary" for the 
entire database.    The report header will read "Activity Summary between <date> and 
<date>".

Example



Example:    Activity for Date Range (Summary)
                                                            
                                                QUICK START COMPANY                      Sat 10/26/91
10:35

Activity Summary between 10/01/91 and 10/15/91
Selection by Person - Any of the following categories

Client-Full billing 

Mrs. Alicia A. Andrews CEO
10/12/91 08:46 PM      Conference re: cash flows.    Signed for line of credit 
10/02/91 11:45 AM      Open file. Needs cash flow studies.

Mrs. Catherine C. Carter V.P.
10/10/91 09:30 AM      Loan submitted.
10/06/91 01:30 PM      Conference with Ms. Carter re: loan package.

Mr. Donald D. Downes Genl. Mgr.
No Activity

Mr. George G. Gordon Owner
No Activity

Ms. Kathy K. Kraus 
No Activity

Mr. Leo L. Lindstrom V.P.
No Activity

Mr. Nicholas N. Nero Partner
10/15/91 10:00 AM      Conference re: inventory financing.
10/08/91 02:55 PM      Open file.    Called re: inventory financing.

Mr. Ned N. Norris Owner
No Activity

Mr. Orville O.    Otis Pres.
10/15/91 11:26 AM      SBA approved loan.
10/09/91 10:10 AM      Sent letter to Regional SBA re: credit error.
10/05/91 03:15 PM      Loan rejected.

Mr. Sheldon S. Smith 
10/15/91 02:15 PM      Settled on loan. 

Mr. Thomas T. Trump Owner
10/15/91 02:45 PM      Loan submitted.
10/08/91 08:45 AM      Conference with Mr. Trump re: package done.
10/01/91 09:30 AM      Signed for equipment loan packaging.



People in Subset

This report will show the selection criteria for the subset, and then list only the names of 
those in the subset (example:    Board Members; volunteers; Committee Chairpersons, etc.)    The 
report header will read "People In Subset Summary".

Example



Example:    People in Subset

                                                QUICK START COMPANY                      Sat 10/26/91
10:15

People in Subset Summary
Selection by Person - Any of the following categories

Independent Contr. 

Mr. Byron B. Bloodsworth 
Mr. Horace H. Hafftone 
Mr. Victor V. Vorhees 
Mr. Walter W. Wheeler 
Mr. Winchell W. Wright 



Database Statistics

This report lists the total number of people in your database, the total number of events in your 
database, and the quantity in each "People Category"    as well as the quantity of each type of 
"Event Category" that has been selected.    The report header will read "Database Statistics 
Report".

Example



Example:    Database Statistics

                                                            QUICK START COMPANY                      Mon 10/21/91 23:30
                                          KBS: PMS - Database Statistics Report

                    Total People on File      50          Total Events on File      117

                    Count of People Categories        Count of Event Categories
                    --------------------                   --------------------
                    Employee                               4           File opened                        47
                    Independent Contr.           5            Estimate prepared            2
                    Volunteer                             4            Contract prepared            2
                    Client-Full billing        11          Contract signed                15
                    Client-Partial bill         4            Contract rejected            0
                    Prospective client           4            Demographics done            2
                    CPA                                       3            Projected Cash Flow          8
                    Lawyer                               5            Current Cash Flows            7
                    Banker                                 3            Profit/Loss Analys            1
                    Government Agency         2            Market study done              4
                    Committee member           0            Balance Sheet Analy        0
                    Contributor                     4            Loan package done          5
                    Service Business             4            Loan submitted                  6
                    Wholesale Firm                 6            Loan approved                    6
                    Retail Firm                       5            Loan rejected                    1
                    Restaurant/Hotel  1            Project Started                0
                    Non-profit Agency           1            Project Completed            12
                    Educational                       1            Follow Up Sent                  0
                    (Open)                                 0            Follow Up Returned              0
                    (Open)                               0            (Open)                                  

    0



 



Labels

With this feature, you select those you wish to make labels for, by any selection criteria 
you choose,    and select "Labels" from the "Reports" menu.    Labels are available in the three 
most popular formats:

Labels - 1 Up
Labels - 2 Up
Labels - 3 Up



Labels - 1 Up

 Bruce B. Baker
 156 Second Street
 Del Ray, FL    31558

 Byron B. Bloodsworth
 3562 St. Martins Road
 Marco Island, FL    34588

 Horace H. Hafftone
 HAFFTONE MARKET DATA
 954 Bridge Road
 Atlantic City, NJ    36958

 Jerry J. Jardin
 QUICK START COMPANY
 22 Duck Lane
 Dames Quarter, MD    21855

 Kelly K. Kendall
 QUICK START COMPANY
 15 Merry Lane
 Goodland, FL    33588

 Larry L. Lang
 QUICK START COMPANY
 522 Caribou Circle
 Marco Island, FL    33588

 Linda L. Lyons
 LYONS PERSONNEL SERV.
 258 Monk Court
 Marco Island, FL    34588

 Martin M. Meford
 QUICK START COMPANY
 544 Ten Eyck Avenue
 Goodland, FL    33588

 Richard R. Righter
 653 Mountain Road
 Marco Island, FL    34588





Labels - 2 Up
 Andrew A. Adams                                David D. Damon
 ADAMS APPLES                526    Butler Court
 1034 West Covina Ave.                                      Marco Island, FL    34588
 San Francisco, CA    65897

 Doug    Darling                                                      Ernest E. Endicott
 258 Citrus Circle                                              ENDICOTT & CO.
 Annapolis, MD    21855                                        954 East Berlin Road
                                                                                  Dover, DE    22801

 Fred F. Feeble                                                    Gregory G. Gissell
 FIRST UNION BANK                                            652 Relaxing Road
 2200 Financial Square                                      Wheeling, WV    26584
 Asheville, NC    33445

 Gary G. Grier                                                      Henrietta H. Harding
 6589 Sunshine Terrace                                      SBA South Region
 Marco Island, FL    34588                                  1500 Federal Building
                                                                                  Washington, DC    22150

 Iris I. Isabella                                              John    J. Jones
 IMMANENT ISSUES                                                JUST JONES JALOPIES
 354 Montrose Avenue                                          66 Mockingbird Lane
 Lawton, PA    21548                                              Suitland, MD    21995

 Marilyn M. Monfort                                            Oscar O. Owings
Marco Island, FL    34588                                  OWINGS & ASSOCIATES
                                                                                  3630 So. Parin Way
                                                                                  Vero Beach, FL    33547

Thomas T. Trueblood
TRAILERS & TOPS
665 Shorline Drive
Marco Island, FL    34588



Labels - 3 Up
Andrew A. Adams              Alicia A. Andrews                Bonnie B. Butler
ADAMS APPLES                          ATTITUDE ADJUSTERS, INC. BUTLER BONDING
1034 West Covina Ave.        5548 W. Third Avenue          2590 Main Street
 San Francisco, CA    65897 Washington, DC    25894        Orlando, FL    31552

 Catherine C. Carter            Carl C. Chamberlin              Donald D. Downes
 CATHY'S CANDIES                    CHAMBERLIN ACCOUNTING    DAKOTA DOZERS
 1500 Industrial Rd              6520 Reservoir Road            6635 Power Court
 Marco Island, FL    333927 Atlanta, GA    28555              Detroit, MI    98552

 Felix F. Farnsworth            George G. Gordon                  Ira I. Irvings
 FARNSWORTH & ASSOC.,P.A. GORDON'S GOODIES                  IRVING INK PADS
 1250 S. Main Street            1245 Baker Lane                    95 Morris Avenue
 Bakersfield, AL    66548      Columbia, SC    55421            Morristown, NJ 55841

 Iris I. Isabella                  John    J. Jones                      Kathy K. Kraus
 IMMANENT ISSUES                    JUST JONES JALOPIES            KLOSETS BY KRAUS
 354 Montrose Avenue            66 Mockingbird Lane            1500 Joiner Avenue
 Lawton, PA    21548                Suitland, MD    21995            Ft. Lucie, FL    33588

 Leo L. Lindstrom                  Nicholas N. Nero                  Ned N. Norris
 LINDSTROM LIGHTING              NATURAL NUTRITION                NIGHT NOTIONS
 542 Separate Drive              1250 Straight Street          652 Windmill Drive
 Naples, FL    33588                Naples, FL    33590                Allendale, FL    33687

 Orville O.    Otis                  Patricia P. Porter              Sonny S. Shapiro
 ORTHODONTICS BY OTIS          PORTER PLASTICS, INC.        SUBURBAN SUNLMP
 663 Main Street                    1600 Plainfield Drive        1526 West Boulevard
 Ft. Lauderdale, FL    33699 Orlando, FL    34588              San Franc, CA    
65897

 Sheldon S. Smith                  Thomas T. Trueblood            Thomas T. Trump
 SS SMITH'S SEAFOOD              TRAILERS & TOPS                    TREE TRIMMERS
 1400 Pallisades Ave.          665 Shorline Drive              26 Cedar Way
 Marco Island, FL    34588    Marco Island, FL    34588    BocaRaton, FL    
33487



 





What is Quick Start
QUICK START COMPANY is a consulting firm providing business services to small and 

medium size companies.    They have employees, and also use independent sub contractors to 
supply studies, analyses, and advice on various business matters.    Some of the services they 
provide are complete cash flow analyses, marketing and demographics research,    and 
preparation of loan packages when the need is indicated by their research.    They also advise on 
federal and state tax matters.

For small businesses that cannot afford necessary services, QUICK START uses a 
volunteer base from the community, S.C.O.R.E. (Service Corps of Retired Executives), and local 
college students (as class projects or assignments).    These clients pay reduced rates that their 
business can support.

They have been using KBS: People Management    System for about six months now, 
and are not sure what    information will be available by using the system.    QUICK START 
COMPANY has asked their employees and volunteers to assemble a    list of questions that might 
be answered by a comprehensive database.    The list is attached.

QuickStart Questions #1 - About Individual People in the Database
QuickStart Questions #2 - About Groups (Subset Lists)
QuickStart Questions #3 - Information By Date or Date Range(s)
QuickStart Questions #4 - Reports Desired
QuickStart Questions #5 - Creative Searches and Reports

Quick Start and Dealing with Values
QuickStart Questions #6 - About Individual People in the Database
QuickStart Questions #7 - About Groups (Subset Lists)
QuickStart Questions #8 - Information Through Reports
QuickStart Questions #9 - Creative Use of PMS



Quick Start Questions - Category #1 - About Individual People in the Database

Is John J. Jones in our Database?

What is his Address?

What is his business phone number?

Is he a CPA?

When was the last time we had contact with Mr. Jones?

When was his file opened?

Is SUBURBAN SUNLAMPS in our database?

What is the name of our contact person with that firm?

What is his home phone number?

On what date did we complete our project with SUBURBAN SUNLAMPS?

What happened at the 6/18 conference with Mr. Sonny Shapiro?

Byron Bloodsworth is an independent contractor.    What is his area of specialty?



Is John J. Jones in our Database?

Hint
Answer
Procedure



What is his Address?

Hint
Answer
Procedure



What is his business phone number?

Hint
Answer
Procedure



Is he a CPA?

Hint
Answer
Procedure



When was the last time we had contact with Mr. Jones?

Hint
Answer
Procedure



When was his file opened?

Hint
Answer
Procedure



Is SUBURBAN SUNLAMPS in our database?

Hint
Answer
Procedure



What is the name of our contact person with that firm?

Hint
Answer
Procedure



What is his home phone number?

Hint
Answer
Procedure



On what date did we complete our project with SUBURBAN SUNLAMPS?

Hint
Answer
Procedure



What happened at the 6/18 conference with Mr. Sonny Shapiro?

Hint
Answer
Procedure



Look for him in the "people list" on your main PMS screen



Yes.



Highlight or click your mouse on any person in the "People List".    This is the list that  begins
with "Adams, Andrew, A.".    Use the scroll bar at the right to go down the alphabetical people list 
to the J's, or for more speed, type a "J" on your keyboard.    Continue going down the list till you 
come to his name (or the absence of it).



Select "Update" above "people list".



66 Mockingbird Lane, Suitland, MD    



When you find his name, highlight it.    Then, select the "Update" button above the people list; the
"People Update" screen will appear.    You may read his address there, and then select "Cancel" to 
go back to the main screen.    A faster way to get the People Update screen is to double click on 
Mr. Jones's name.



Select "Update" above "people list".



1-(202) 659-8847



Double click on Mr. Jones's name again to read the phone number.    Select "Cancel" to return to 
the main screen.    It is a good habit to select "Cancel" on any screen you look at without making 
any changes.    If you inadvertently make an entry with the or keyboard, you will not change any 
of your database records by mistake.



Select "Update" above "people list".



No.



Again, double click Mr. Jones's name, or select the "People Update" button.    Look at the "people 
categories" on the right side of the screen.    You can see that he is a "prospective client", and 
also a "Retail Firm".    But, he is not a "CPA".    Whenever you search this database, you can find 
Mr. Jones by asking for a subset list including either "prospective clients", or "Retail Firms".      
When you set up your first PMS database file, you will be asked to name these 20 categories.    
You should choose categories that your business or organization recognizes as normal in your 
business.



Look in the "event list" on the bottom of your main PMS screen.



July 13, 1991 at 10:00 am.



On the main PMS screen, highlight Mr. Jones.    Look at the bottom of the screen in the "Events 
Box".    All events entered into your database involving Mr. Jones will appear there, in reverse 
chronological order, by date;    If there are multiple events, the last one will be on top of the list.    
There has only been one contact with Mr. Jones.    The date and time appear on each event; then 
the words that follow, which are his "Event Title'.    Each time you add an event to your PMS 
database, you will be asked to provide an event title.    You should choose the words that you 
want to appear on the main screen when his name is highlighted.    You will also have the 
opportunity to record comments or details about the event which will not appear on the main 
screen until you go get them.



Select the "Update " button at the bottom of your main PMS screen.



July 13, 1991.



Althought the listing in the event box for Mr. Jones does not supecifically say so, since there is 
only one event, one might assume his file was opened on that date. This may, or may not be 
true.    Highlight the event, and select the "Update" button to the right of the event box.    The 
Event Update screen will appear, and you will see that "File Opened" is checked.    Now you are 
sure.    You may want to include a category like this when you set up your first PMS database; as 
you get to select all 20 categories to match your business or organization needs.    A faster way to
get the "Event Update" screen is to double click on the event.    To return to the main PMS screen, 
select "Cancel".



Select    "Display Company" under "Options" menu, and find on the "people list".



Yes.



Select "Display Company" from the "Options" menu.    The people list changes.    It now lists 
company names in alphabetical order.    If the person in your database did not have a company 
name when it was entered into the database, his name will appear on the people list (instead of a
company name).    Highlight any name in the people list.    Now scroll to the "S"'s or enter an "S" 
from your keyboard.    Continue down the list to see if there is a 'SUBURBAN SUNLAMPS".    There 
is.



Select "Update" above "people list".



Mr. Sonny Shapiro.



Highlight "SUBURBAN SUNLAMPS" in the people list.    Now, double click his name, or select the 
"Update" button above the people list.    The "People Update" screen will appear.    You will see Mr. 
Shapiro's name, his company name, and the balance of the information that was added to the 
database through the "Add Person" function under the "Maintenance" menu (or by Import).    
Leave the People Update screen by selecting "Cancel".    You will be returned to the main PMS 
screen.



Select "Update" above the people list.



1-(556) 693-2213.



Double click "SUBURBAN SUNLAMPS" to enter the People Update screen.    After you read his 
home phone number, select "Cancel" to return to the main PMS screen.    Note that whether you 
are displaying the company names, or the individual's names, all "people" information comes 
from the same screen.    Regarding the home phone number you just verified, you can autodial 
Mr. Shapiro at his home at any time without entering the phone number.    PMS will do it 
automatically for you; and will also dial the business or fax number.    One word of caution here:    
be sure to enter the phone numbers in the form that your modem requires.    Many modems 
require a particular format, like "1-301-654-9999", or "1(301)654-9999".



Go to the "event list" on lower part of main PMS screen.



June 18, 1991.



Look at the events that arelisted in the event box at the bottom of your screen when you have 
"Mr. Shapiro" or "SUBURBAN SUNLAMPS" highlighted.    Again, you cannot be sure that the last 
contact is when the project was completed (he may have contacted you after it was completed).   
Try double clicking the first event on the list (the one with the most recent date).    The Event 
Update screen will appear, and in checking the event categories at the right of this screeen, you 
see that there is a checkmark next to the "Project Complete" category.    Select "Cancel" to return 
to the main PMS screen.



Use the Event Update screen.



We discussed cash flows, and he is satisfied.    Project complete.





Quick Start Questions - Category #2 - About Groups (Subset Lists)

How many lawyers are there in our database, and who are they?

Are there any lawyers who also hold the title of "CPA"?

Determine how many lawyers in our database are NOT CPA's;    and their names.

Determine a list of all persons connected with government agencies; and list them by their 
agency names.

Determine a list of all clients that are not being billed full rates.

Determine a list of all companies for whom we have done Projected Cash Flows.

Restrict the names in the "people list" on the screen to those who are not employees, and not    
independent contractors, nor volunteers.

How many prospective clients are we working with at this time?

Name all the people for who we have both submitted loans, and those loans were approved.

How many people have signed contracts with us, but the projects are not yet checked "complete"
and who are they?



Byron Bloodsworth is an independent contractor.    What is his area of specialty?

Hint
Answer
Procedure



How many lawyers are there in our database, and who are they?
Hint
Answer
Procedure



Are there any lawyers who also hold the title of "CPA"?
Hint
Answer
Procedure



Determine how many lawyers in our database are NOT CPA's;    and their names.
Hint
Answer
Procedure



Determine a list of all persons connected with government agencies; and list them by 
their agency names.
Hint
Answer
Procedure



Determine a list of all clients that are not being billed full rates.
Hint
Answer
Procedure



Determine a list of all companies for whom we have done Projected Cash Flows.
Hint
Answer
Procedure



Restrict the names in the "people list" on the screen to those who are not employees, 
and not    independent contractors, nor volunteers.
Hint
Answer
Procedure



How many prospective clients are we working with at this time?
Hint
Answer
Procedure



 Name all the people for who we have both submitted loans, and those loans were 
approved.

Hint
Answer
Procedure



How many people have signed contracts with us, but the projects are not yet 
checked "complete", and who are they?

Hint
Answer
Procedure

 



Don't take the easy way.    This question could be asked about any person in your database; it just
so happens that we are looking closely at SUBURBAN SUNLAMPS, and Mr. Shapiro.    Go to the 
"Options" menu and select it.    You will see a check mark next to"Display Company".    Although it 
is fairly obvious with the Quick Start Company database to see that you are in the "Display 
Company" mode (all his companies were entered with capital letters), you may check at any time
by looking here.    When there is no check by "Display Company", the display is set on individuals'
names. Select "Display Company" now.    The check mark is gone, and the people list now shows 
personal names, in alphabetical order.    Find Sonny Shapiro, and highlight his name.      Now look 
at the event title for 6/18, in the event box at the bottom of the main PMS screen.    All it tells you
about the 6/18 event is that is was a conference, on that date, and the time of the conference 
was 4:00 p.m..    To get further information, double click the 6/18th event, or select the Event 
Update button to the right of the event box.    You will see the same title that appeared on the 
main screen.    Just below it is the "Event Comments" box, where it has been recorded that the 
subject matter of the conference was cash flows.    And, he is satisfied.    To the right of this screen
are the 20 Event Categories.    The one check for this event is "Project Completed".    This 
information was put into QUICK START COMPANY's database by the "Add Event" function.    The 
event comments could have been up to approximately 1,000 characters.    Any information could 
have been entered, and yet only the event title will appear on the main PMS screen.    When the 
event comments exceed the amount that can be shown on your screen, scroll bars will appear to 
the right of the comments box, so you can read the enter comments recorded.    Multiple Event 
Categories could have been checked.    You may search by these categories    when you develop a 
"working database" by using "Subset Lists".    If you selected the Event Update button without 
first selecting (highlighting) the event, you got an error message reminding you to select the 
event you wish to see the information on.



Check the "People Comments" box.



Commercial real estate consulting.



Find Byron Bloodsworth in the people list, and highlight his name.    Look to the right, and you will 
find some notes about Mr. Bloodsworth that answer the question.    This area of the screen is 
called the "People Comments" or "Personal Comments" box.    The comments recorder here may 
be entered at any time by tabbing to or clicking anywhere on this box.    The comments appear 
only when the individual's name is highlighted.    They may be as long as 1,000 characters, and 
long comments may not be all visible on one screen.    When they exceed screen length, a scroll 
bar will appear to the right of the comments box, so you can read the entire comments box 
contents.



Select    "People - Any Check" from "Subset List" menu.



There are five.    Chase, Edgerly, Moonstruck, Phillips, and Vanderhood.



Select "Subset List" from the menu bar at the top of your main PMS screen.    Select "People - Any
Check";    and a subset list screen will appear.    This is the "People Subset" list.    On it your will see
listed the 20 checkboxes you saw before, when you used the People Update function.    There are 
two series of boxes; "Yes" boxes, and "No" boxes.    The header on this screen reads "Match any 
Check", and that is what PMS will do.    Tab to the "Yes" box next to "Lawyer", and hit your space 
bar, or point to the box with your mouse cursor and click once.    An "X" will appear in the box you
have selected.    PMS has all the information needed from you to develop a subset list, that will 
only list the people in your database that have been checked "Lawyer". Select the "OK" button on
that screen, and watch what happens.    The box in the top center of your screen that read "50 of 
50 Records Selected" now reads "5 of 50 Records Selected".    Just below that box, the message 
"Full Database" has changed to "Subset", so you know you are limited to a "working database".    
The names in the people list has been reduced to lawyers; five of them.    And, there is one more 
change; a new box has appeared on the top right (just under the "Options" menu), that reads 
"People - Any Check".    It also has a drop box.    Click on the drop box.    As long as you are in this 
subset, you may come here at any time to verify exactly what search criteria the subset is based 
on:    People Any Check -Lawyers.    To remove the drop box, click on the drop box arrow again, or 
click or tab anywhere on the screen. Click on any lawyer's name, and his personal comments and
events appear in their respective boxes.



Select "People - All Checks" from "Subset List" menu.



One.    Clinton C. Chase.



If you click on Mr. Chase's name, and look to the right of his name in the personal comments box,
you will see that it mentions that he is a CPA.    However, he may not be the only one. Since both 
"lawyer" and "CPA" are People Classifications, there is a way to answer the question definitively.    
Select the "Subset List" menu.    Then select    "People - All Checks" and a subset list screen will 
appear.    This is the "People Subset" list.    On it your will see listed the 20 checkboxes you saw 
before, when you used the People Update function.    There are two series of boxes; "Yes" boxes, 
and "No" boxes.    The header on this screen reads "Matches All Checks", and that is what PMS 
will do.    Tab to the "Yes" box next to "Lawyer", and hit your space bar, or point to the box with 
your mouse cursor and click once.    An "X" will appear in the box you have selected.    Now do the
same for "CPA"; put an "X" in the 'Yes" box next to that title.    PMS has all the information 
needed from you to develop a subset list, that will only list the people in your database that have 
been checked "Lawyer" and also "CPA".    Lawyers that are "Not" CPA's will not be part of the 
subset.    CPA's that are not lawyers will not be part of the subset list.    Only those persons who 
match ALL checks will be part of the subset.    Select the "OK" button on that screen, and watch 
what happens. One one record is selected. and that is Clinton C. Chase, Esq..    Double click his 
name in the people list, and look at the People Update screen.    You will see that both boxes are 
checked.    Select "Cancel".    Now click on the drop box that says "People - All Checks", and verify 
the search criteria.    



Select "People - Any Check" from "Subset List" menu.



Four;    Edgerly, Moonstruck, Phillips, and Vanderhood.



With your deductive reasoning, you could answer this question without the help of PMS's search 
criteria.    But, the questions are not always this easy.    The real question is,    how can I develop a 
subset list with this criteria:    Yes, he is a lawyer; No he is not a CPA.    Select "Subset List" from 
the menu.    Click an "X" in the NO box for CPA.    Click an "X" in the Yes box for Lawyer.    Select 
"OK".    PMS has used positive and negative inquiry criteria.    Click on the drop box again to see 
how the search criteria is displayed.



Select "People - Any Check" from "Subset List" menu.    Then, select "Display Company" from 
"Options" menu.



There are two.    Henrietta Harding with the SBA,    and Ronald Ripkins with Collier Planning. 



Select "Subset LIst" from the menu.    Select "People - Any Check".    Put an "X" by the Yes box 
next to "Government Agency".    Select "OK".    Now you will see the two people.    Select "Options"
from the menu bar.    Select "Display Company".    Now you will see their agencies.    You may use 
the "Company Name"    entry however you wish when you are adding people to your database.    
[You may find some creative use for this function if company names are less important to you.    It
is possible to use the primary name for each company, and record the contact's name in the 
personal comments box.    Each time you click on the company name, the contact's name will be 
visible to the right ; in the personal comments box.    This would allow you to use the Company 
Name for any alpha-numeric input you wish to have as an alternate display.]



Select "People - Any Check" from "Subset List" menu.



There are four:    Butler, Irvings, Porter, and Shapiro.



QUICK START COMPANY is set up to differentiate between full billing and partial billing clients.    
They have done this by using the People Categories, and checking the one that applies for each 
client.    Select "Subset List" from the menu.    Select    "People - Any Check".    Put an "X" in the Yes
box next to "Client -Partial bill".    Select "OK".    If you don't see the individuals' names, you did 
not undo the "Display Company" feature under the "Options" menu.    Do so now.



Select "Event - Any Check" from "Subset List" menu.



There are eight:    ATTIDTUDE ADJUSTERS, CATHY'S CANDIES, LINDSTROM LIGHTING, NATURAL 
NUTRITION, ORTHODONTICS BY OTIS, PORTER PLASTICS,    SMITH'S SEAFOOD, and SUBURBAN 
SUNLAMPS.



Select "Subset List" from the menu.    Select "Event - Any Check"; the "Subset List for Events" 
screen will appear.    Put an "X" in the Yes box next to "Projected Cash Flows".    Select "OK".    PMS 
will search through each person's file, and if he has a check next to "Projected Cash Flows" (in 
any of the events for any person), PMS will make him part of the subset list.    The subset list 
shows you eight people in the people lists.    Since the question asks for "companies", select 
"Display Company" under the "Options' menu.



Select "People - All Checks" from "Subset List" menu.



There are 37 people in the list.



These criteria are "People Categories".    Select "People -    All Checks" from the Subset List menu.  
Put an "X" in the No boxes for "Employee",      "Independent Contractor" and Volunteer".    Select 
"OK".    If you show 37 companies, you did not reset the "Display Company" feature.    If QUICK 
START COMPANY wanted to send a company newsletter to everyone except employees, 
independent contractors, and volunteers, they could print mailing labels from the current subset 
list, and accomplish this.



Select "People - Any Check" from "Subset List" menu.



Four:    Adams, Isabella, Jones, and Trueblood.



It should be getting easier by now.    "Prospective Client" is a people category, so select "People - 
Any Check" from the "Subset List" menu.    Put an "X" by "Prospective Client", and select "OK".    
Don't forget to restore to full database.    If "Prospective Client" was one of your categories, it 
would be important to remember to update the information on his people screen when he 
became an actual client.    You may update people and event information as often as you want.



Select "Event - All Checks"; select "Loan Submitted" and "Loan Approved".



There are five:    Andrews, Carter, Norris, Otis, and Trump.



From the "Subset List" menu, select "Event - All Checks".    When the "Matches All Events" screen 
appears, put an "X" in the Yes box next to "Loan Submitted", and an "X" in the Yes box next to 
"Loan Approved".    Select "OK" to return to the main PMS screen.



Select "Event - All Checks";    select "Contract Signed" and check "No" for "Project 
Complete".



There are three:    Carter, Downes, and Otis.



From the "Subset List" menu, select "Event - All Checks".    When the "Match All Checks" screen 
appears, put an "X" in the Yes box next to "Contract Signed", and put an "X" in the No box next to
"Project Complete".    Select "OK" to return to the main PMS screen.    Any program is only as good
as the input; if the project was, in fact, complete, but the "Project Complete" category was never 
checked, that person would be produced in this subset search.    Once you get use to PMS, you 
will be able to think of ways to periodically check the quality of input; there are some suggestions
in the manual.





Quick Start Questions - Category #3 - About Individual People in the Database

 List all people in the database that were added between June 30, 1991 and September 30, 1991.

Structure the database information so that only events occuring after September 30, 1991 are 
shown on the screen.

On what date did we complete the project for LINDSTROM LIGHTING?

List the firms for whom we have done a market study since October 1, 1991.

How many projects have been completed in the third quarter?

On date did we order the appraisal for Sheldon Smith?



List all people in the database that were added between June 30, 1991 and 
 September 30, 1991.
Hint
Answer
Procedure



Structure the database information so that only events occuring after September 30, 
1991 are shown on the screen.
Hint
Answer
Procedure



On what date did we complete the project for LINDSTROM LIGHTING?
Hint
Answer
Procedure



List the firms for whom we have done a market study since October 1, 1991.
Hint
Answer
Procedure



How many projects have been completed in the third quarter?
Hint
Answer
Procedure
 



On what date did [so and so] do [such and such]?
Hint
Answer
Procedure



Select "Set Date Limits" from "Subset List" menu.    Set date.    Find "Files Opened".



There were 19 additions during this time period.



The first thing we need to do is to set the search date limits.    Select "Set Date Limits" from the 
"Subset    List" menu.        A pop up menu will appear entitled "Set    Event    Search Dates". To 
change the dates to read June 30, 1991 (Start Date) and September 30, 1991 (End Date), follow 
this procedure.    Tab to the first field in the "Start Date" box, or click on it with your mouse cursor. 
If you press the "delete" key on your keyboard, you may type the new month in this box.    Or 
alternately, you may use the scroll box on the right hand side of the box.    When this field says 
"6" (for June), tab to the day box and change it to read "30" by the same method.    If the year is 
correct, move your cursor to the "End Date" box, and use the same method to change the date to
read "09/30/91".    Select the "Set" button to tell PMS you want that function "ON", and then 
select "OK" to end the date set function.    A message will appear above and to the right of the 
people list that says "Date Set" to remind you that the date limit function is enabled.    Now we 
need to answer the question of who was added to the database during this time period.    The 
QUICK START COMPANY uses the Add Event function to mark files when they are first opened.    
The check the box that says "File Opened" the "Subset List" menu, select    "Event - Any Check".    
When the Match Any Check PMS has searched each event in your database for ones that are 
market "File Opened", but only between the date range you specified.    Then he has listed the 
names of the people that had the events in their files.    There are 19 such people. Find Orville 
Otis in the people list and highlight his name.    Looking in the event box at the bottom of the 
screen, you will see that he has eight events listed.    None of them refers to the opening of his 
file, so how did PMS make the selection?    From the "Options" menu, select    "Show Only 
Selected Events".    Now look at the event box - there is only one event which matches the search 
criteria.    To verify this, double click the event, or highlight the event and choose the Update 
button to the right of the event box.    You will see that the "File Opened" box is checked.    This 
feature (Show Only Selected Events) will help you find exactly what you are looking for, without 
"wading" through unnecessary volumes of data.    Select "Cancel" to leave the Update screen.    
Now look on the top of your main PMS screen, in the center and below the box that now reads 
"10 of 50 Records Selected".    The message "Date Set" is to remind you that the date set function
is enabled.    There is also a message that reads "Selected Events".    This will remain there to 
remind you of the mode you are in until you turn the function off.    To leave this mode, select 
"Show Only Selected Events" from the "Options" menu again.    The check mark to the left of this 
title will be removed, and so will the message in the center of your screen.    Do this.



Select "Set Date Limits" from the "Subset List" menu.    Select "Show Only Selected Events" from 
the "Options" menu.



Yes, PMS can do it.    The messages in the top center of your main PMS screen will                 read 
"Date Set" and "Selected Events".



Select "Set Date Limits" from the "Subset List" menu.    Using the procedure outlined previously 
(Question #21), set the Start Date at October 1, 1991 ("after" 9/30/91).    Set the End Date at 
some date after the last database entry.    I changed the year to read "1995", so it would be
obvious the next time I went to Set Date Limits.    Select "Set" and "Select "OK".    This will return 
you to the main PMS screen.    Under the "Options" menu, select "Show Only Selected Events".    
Two messages will show in the top center of the main PMS screen:    "Date Set" and "Selected 
Events".    To verify your success, click on "Adams, Andrew A." in the people list.    No events 
should show in the event box in the bottom portion of the screen.    Now go back to the "Options" 
menu, and again select "Show Only Selected Events".    This will toggle the fuction "off", and you 
will see an event below.    The event was entered in the database on 6/18/91 - outside of the 
search criteria of the question.    Now click on "Andrews, Alicia A..    Seven events show in the 
event box below.    Go back to the "Options" menu and once more select "Show Only Selected 
Events".    The feature is toggle back "on", the message Selected Events" shows at the top of your
screen, and there is no change in the number of events that appear below.    This is because all of
the event occured after 9/30/91; all are within your search criteria.    To learn a little more about 
"Set Date Limits", try the following procedure.    Turn the "Show Only Selected Events"    function 
off; checking to make sure the "Selected Events" message in not showing in the top center of the 
main PMS screen.    Now "Event - Any Check" from the "Subset List" menu.    Put an "X" in the Yes 
box for "File Opened" and select "OK".    Notice that Mr. Adams is no longer    in your people list.    
He was not selected because the event we chose did not occur in the date range named (the 
"Date Set" message shows your date is still set).    The reason he was on the list previously is 
because you set the date when you had the full database in your "working database".    That is 
also why we used the "Show Only Selected Events" function in that instance.    To develop good 
PMS habits, you should go to the "Subset List" menu and select "Restore Full List", to bring your 
"working database" back to the complete list.    Go back to the "Subset List" menu and select "Set
Date Limits" to turn off the date limits.    If your screen reads "Selected Events", go the the 
"Options' menu and select "Show Only Selected Events" to turn that function off.    Your database 
is fully restored, with all limitations removed.



Select "Display Company" from "Options" menu. 



September 22, 1991.



Since the question deals with a company name, rather than an individual, go to the "Options" 
menu and select "Display Company".    Your people list will now show company names.    Highlight 
any name and type an "L", or scroll down the list to "Lindstrom Lighting".    Looking at his events 
below, you cannot be certain if the project was completed on the last contact date, so double 
click the last event, or highlight the last event and select the Event Update button, to check the 
Event Update screen.    Yes, the "Project Completed" box is checked.    Select "Cancel to return to 
the main PMS screen.    You could have found this answer using the "Event - Any Check" search in
the "Subset List" menu, together with the "Show Only Selected Events" function.    The only 
event that would have appeared would have been the one that corresponded to the search 
criteria:    the event that was checked "Project Completed".    A similar example will be given 
later in QUICK START.



Select    "Set Date Limits"    from "Subset List" menu; then "Event - Any Check"; then Select 
"Display Company" from "Options" menu. 



There is one:    BUTLER BONDING.



Select "Set Date Limits" from the "Subset List" menu.    Notice that the dates showing are 
adequate for our search (Start date = October 1, 1991; End Date = some time in the future).    
But, the dates are not "set".    Select the "Set" button, and then select the "OK" button.    Next, 
select    "Event - Any Check" from the "Subset List" menu.    Put an "X" by the Yes box next to 
"Market Study Done", and select "OK".    Since we are looking for "firms", turn on the "Display 
Company" function under the "Options" menu.    "Restore Full List" under the "Subset List" menu.  
Turn off the "Set Date Limits" function under the "Subset List" menu - select "Clear", then select 
"OK".    Turn off the "Display Company" function under the "Options" menu.



Select    "Set Date Limits"    from "Subset List" menu; then "Event - Any Check".



Six:    Gordon, Irvings, Kraus, Lindstrom, Norris, and Porter.



Select "Set Date Limits" from the "Subset List" menu.    Set the Start Date to read "07/01/91", and
the End Date to read "09/30/91" (the third quarter is July, August, and September).    Next, select 
"Event - Any Check" from the "Subset List" menu, and put an "X" next to the Yes box next to 
"Project Completed".    Highlight George Gordon in the people list, and look at his events.    Look at
some of the others, as well.    Now, select the "Show Only Selected Events" function under the 
"Options " menu.    Now highlight each person on the list and look below at their event(s).    Each 
shows only the event that caused their selection into this subset list.    If you want to list their 

companies, toggle the "Display Company" function under the "Options" menu.    Restore 
the database and clear the date, using the "Subset List" menu, and return the people list to 
individuals' names.



Don't work too hard.    Find him and look at his event titles.



September 27, 1991.



You probably looked at the HINT already.    Don't make everything difficult, just because you have 
a program that will make multiple event searches.    Select any name in the people list and type 
an "S".    Continue scrolling down the list (one more name) to find Mr. Smith.    Look in the event 
box at the bottom of the screen.    There is your answer.    Remember, the event titles are 
important.    And, not every event has to have a box checked to be found easily.    



Search for "Projected Cash Flow" and "Loan Submitted".    Use the date range and show only 
selected events to determine when the loans were actually submitted.



Two were submitted in Sept: Otis and Smith.    Two in Oct.: Andrews and Carter.



You might come up with the wrong answer on this one unless you think like a computer.    
Although we are asking about cash flow projections, on of the Event categories, the date range 
part of the question only applies to the submission of the loans.    If you set the date for the 
search, you will only find two of the four people that have such events.    This is because their 
projected cash flow events occurred prior to September.    So, do it this way:    Select "Event - All 
Checks" from the "Subset List" menu.    Put an "X" in the Yes box next to "Projected Cash Flows", 
and an "X" in the Yes box next to "Loan Submitted".    Select "OK" to return to the main PMS 
screen.    You now have a list of four people that match both criteria.    Now, let's limit the date 
range for the events to September only.    Select "Set Date Limits" from the "Subset List" menu.    
Change the Start Date to read "09/01/91", and the End Date to read "09/30/91.    Now select 
"Show Only Selected Events" from the "Options" menu.    The event titles in the event box at the 
bottom of your main PMS screen will be restricted to those events only that occurred in 
September.    Highlight Alicia Andrews; she has no events.    Highlight Catherine Carter.    She has 
an event, but it is related to the cash flow projections; not the loan submission.    If you want to be
sure, double click her event and see that "Loan Submitted" is not checked.    Highlight Orville Otis;
only one event shows for September.    It shows the loan submission you are looking for (that's 1). 
Again, if you want to be perfectly sure, double click his event, and your will see that the "Loan 
Submitted" box is checked.    Highlight Mr. Smith.    Same singular event (that's 2).    To finish the 
exercise, repeat the procedure by resetting the date limits:    set the Start Date to read 
"10/01/91", and the End Date to read "10/31/91.    You will verify the other two loan submissions.



There are two separate questions.    Answer them individually.



Two projects were completed:    Kraus and Lindstrom.    No follow ups were sent.



If you set the date limits to September, and searched by both "Project Completed" and "Follow Up
Sent", you will get a response of "0 Records Selected".    There are two separate questions here; 
and even though they depend on each other, and they involve the same people, they must 
remain separate.    When you look at the answer, you can see why.    Since no follow up letters 
were sent out in September (in fact none were ever sent by Quick Start), PMS would have to tell 
you there were no matches to the multiple-event search.    So, let's do it the right way.    Select 
"Set Date Limits" from the "Subset List" menu.    Set the Start Date to read "09/01/91" and the 
End Date to read "09/30/91".    Now, select "Event - Any Check" from the "Subset List" menu.    Put
an "X" in the Yes box next to "Project Completed", and select "OK".    You will find the two people 
whose projects were completed.    Next, we are going to remove the date limits, as the follow up 
letters might have been sent in October (or some other time).    Select "Set Date Limits" from the 
"Subset List' menu.    Select "Clear", and then "OK" when the date box appears.    The "Date Set" 
message no longer shows on your screen.    Select "Event - Any Check" from the "Subset List" 
men, and put an "X" in the Yes box next to "Follow Up Sent", and select "OK".    PMS will tell you 
that no follow up letters were sent.    If there were, in fact, follow up letters sent, you would simply
have looked down the people list to see if Kraus or Lindstrom appeared.    Don't forget to restore 
to full database.



It's two questions again.    Do the search, and look at the events.    If you want to use some 
computer power, use the "Show Only Selected Events" instead of the date limits.



April= 1 (Downes); June= 1 (Gordon); July= 1 (Adams).



The question of when the estimates were prepared is not something you want to tell PMS to 
search for; if you did, you would have to change the date limits once for each month during your 
search period.    And, if you did it that way, you would want to find the people for whom we have 
prepared estimates first, then toggle the date ranges.    With a small database like the one we're 
working with here, we'll use a little common sense.    Select "Event - Any Check" from the "Subset 
List" menu, then put an "X" in the Yes box next to "Estimate Prepared"; select "OK".    You now get
a list of three people for whom estimates have been prepared.    The second part of the question 
is in what month.    Select "Show Only Selected Events" from the "Options" menu.    This will leave 
only the event for each person that was the selection criteria for structuring the subset list.    
Regardless of what the event title says, you will find that the box next to "Estimate Prepared" will 
be checked.    Make note of the month of each event, so you can schedule them.    Don't forget to 
restore to full database.



You have to think like a computer on this one.



"Event - Any Check" will yield all names.    "Event - All Checks" will yield three.



You know the search procedures by now.    But, can you explain why the answer is correct?    To 
understand it, you have to think a little like a computer.    But, if you can do this, you will be better
prepared to ask PMS questions; with predictable and accurate results.    When you specify "Event -
Any Checks", you are asking PMS to find records that have any "No" in any box; of any event.    
Any event record that has the lack of a "Yes" check in any box at all will qualify for the subset list. 
On the other hand, if you ask PMS to get you a list of the people who have records with all "No"'s 
in them, he can find them.    That's because there are records in this database that were recorded
without any checkbox being checked (3 of them).    A good system check might be to require 
some box be checked (perhaps an [open] category, or an [non-classified event] category).    Using
this idea, you would be able to check your database periodically, to verify that each event has 
been entered completely.    Just to go one step further in computer logic, if we had checked every 
event checkbox with a Yes, PMS would only give you 49 names on the first search.





Quick Start Questions - Category #4 - About Individual People in the Database

Prepare a report for, Ms. Alicia A. Andrews, listing her address, all phone numbers, each of her    
"people category" classifications, any personal comments, and a listing of all events logged for 
her name.    Include the date and time of each event logged, and any notes or comments 
recorded for each event in the file.

Prepare a report of    all prospective clients, showing the information required in #33 above).

Prepare a report to print out all the activity in connection with lawyers between August 15, 
1991and September 15, 1991.    Show their address and all phone numbers,               people   
categories,and list their events with the times, date, event titles, and event categories.    Also 
show the event details.

Prepare a report that shows only the last activity for all persons in the database that are 
classified as "Service Business".    List the address, phone numbers, and all people categories.    
When it comes to the events, list only the last one, and do include the event comments.

Prepare a report to show all the activity for lawyers in our database.    List the selection criteria; 
then only their names, together with the activities in the file.    Include times, dates,               and   
event titles.    Do not include event classifications or event comments.

Prepare a report showing each CPA, and the last contact with each one.      Show the event title,    
time and date of the contact, but no other information.

Prepare a report to show the activity for all full-billing clients between October 1 and Oct 15, 
1991.    List each contact on that date, with the persons' names, the time of day of the contact, 
and    the event titles.    Do not show event categories or event comments.

Prepare a report that lists the names of all independent contractors in the database.

Prepare a report that will show the number of people in each "people category" and the number 
of events that have been classified by checking an "event category".

Print out a mailing list for everyone in the database.    Use a label format that is 2 labels across.



Prepare a report for, Ms. Alicia A. Andrews, listing her address, all phone numbers, 
each of her    "people category" classifications, any personal comments, and a listing 
of all events logged for her name.    Include the date and time of each event logged, 
and any notes or comments recorded for each event in the file.
Hint
Answer
Procedure



Prepare a report of    all prospective clients, showing the information required in #31 
(above).
Hint
Answer
Procedure



Prepare a report to print out all the activity in connection with lawyers between 
August 15, 1991and September 15, 1991.    Show their address and all phone numbers,
people categories,and list their events with the times, date, event titles, and event 
categories.    Also show the event details.
Hint
Answer
Procedure



Prepare a report that shows only the last activity for all persons in the database that 
are classified as "Service Business".    List the address, phone numbers, and all people 
categories.    When it comes to the events, list only the last one, and do include the 
event comments.
Hint
Answer
Procedure



Prepare a report to show all the activity for lawyers in our database.    List the 
selection criteria; then only their names, together with the activities in the file.    
Include times, dates, and event titles.    Do not include event classifications or 
event comments.
Hint
Answer
Procedure



Prepare a report showing each CPA, and the last contact with each one.      Show the 
event title,    time and date of the contact, but no other information.
Hint
Answer
Procedure



Prepare a report to show the activity for all full-billing clients between October 1 and 
Oct 15, 1991.    List each contact on that date, with the persons' names, the time of 
day of the contact, and and the event titles.    Do not show event categories or event 
comments.
Hint
Answer
Procedure



Prepare a report that lists the names of all independent contractors in the database. 
Hint
Answer
Procedure



Prepare a report that will show the number of people in each "people category" and 
the number of events that have been classified by checking an "event category".
Hint
Answer
Procedure



Print out a mailing list for everyone in the database.    Use a label format that is 2 
labels across.
Hint
Answer
Procedure



Find and select "Alicia Andrews" on the "people list".    Then, from "Reports" menu,  select "Detail 
Reports"; then "Detail History (Person)".



"See Sample Report    # 1" 



Highlight Ms. Andrews in the people list.    Select    "Detail Reports" from the "Reports" menu.    
Select "Detail History (Person)".    The document is formulated and sent to your WINDOWS TM 
Print Manager.    The report will be printed automatically, unless you select "Cancel"    on the print 
button that appears in the center of your screen, before or during the printing process.



From "Subset List" menu, select "People - Any Check".    Then, select "Detail Reports".    Next, 
select "Detail History    (Subset)".



There are four such persons.    Each is printed on a separate page.    For the first page, See 
"Sample Report #2" .



Select "People - Any Check" from the "Subset List" menu.    Put an "X" in the Yes box next to 
"Prospective Client".    Select "OK".    This will yield a list of the four prospective clients.    Next, 
select "Detail Reports" from the "Reports" menu.    Then select "Detail History (Subset).    The 
report will be printed automatically, unless you select "Cancel"    on the print button that appears 
in the center of your screen, before or during the printing process.    This report will consist of four
individual pages; one for each person on the subset list.    You may cancel any one, or every one, 
if you desire.



Select "Set Date Limits" .    Select "People - Any Check" .      Select "Activity for Date     
Range" report from the "Detail Reports"



There are five lawyers with activity in that date range.    To view the first page of the report, see 
Sample Report #3.



Select "Set Date Limits" from "Subset List menu"; set Start Date to 08/15/91, and End Date to 
09/15/91.    Select "Set"; then "OK".    Select "People - Any Check" from the "Subset List" menu.    
Put an "X" by the Yes box named "Lawyer".    Select "OK".    This search will yield a list of five 
lawyers who have activity in our date range.    Next, select "Detail Reports" from the "Reports" 
menu; then select "Activity for Date Range". The report will be printed automatically, unless you 
select "Cancel" on the print button that appears in the center of your screen, before or during the
printing process.    This report will consist of five individual pages;        one for each person on the 
subset list. If one of the persons in the subset does not have any activity in the date range 
specified, his name will not go to the printer.    You may cancel any one, or every one, if you 
desire.    As before, restore your database to a full database, and turn off the "Set Date Limits" 
function before you proceed.



Search by "People - Any Check" for "Service Business".    Print a "Last Activity " report                
                          from the "Detail Report " section of the "Report Menu".



There are four service businesses.    To view the first page of the four, see Sample                            
Report #4.



First, find all the service businesses.    Select "People - Any Check" from the "Subset List "menu.    
Put an "X" in the Yes box next to "Service Business".    This will yield a list of four persons.    Next, 
select "Detail Reports" from the "Reports" menu; then select "Last Activity".    The report will be 
printed automatically, unless you select "Cancel" on the print button that appears in the center of
your screen, before or during the printing process.    This report will consist of four individual 
pages; one for each person on the subset list.    You may cancel any one, or every one, if you 
desire.    Don't forget to restore the database before proceeding.



Select "People - Any Check" for find lawyers.    Use "Activity Summary" report.



There are five lawyers in the database.    To view the final report, see Sample Report                
#5.



First, find the lawyers.    Select "People - Any Check" from the "Subset List" menu.    Then put an 
"X" in the Yes box next to "Lawyer".    This will yield a list of five lawyers.    Next, select    
"Summary Reports" from the "Reports" menu.    Then, select "Activity Summary". The report will 
be printed automatically, unless you select "Cancel" on the print button that appears in the 
center of your screen, before or during the printing process.    Summary reports are continous, 
and not one page for each individual.    Don't forget to restore the database before proceeding.



Select "People - Any Check" from the "Subset List" menu.    Select "Summary Reports"     from 
the "Reports" menu,    then "Name and Event List for Subset".



There are only three CPA's in our database.    To view the report, see Sample Report                
#6.



First, find the CPA's.    Select "People - Any Check" from the "Subset List" menu.    This will yield a 
list of three CPA's.    Next, select "Summary Reports" for the "Reports" menu.    Then, select "Last 
Activity".    The report will be printed automatically, unless you select "Cancel" on the print button
that appears in the center of your screen,    before or during the printing process.        Summary 
reports are continous, and not one page for each individual.    Don't forget to restore the database
before proceeding.



Select "Set Date Limits";    Select "Event - Any Check" / "Client-Full billing", and    "Summary 
Report" named "Activity for Date Range".



There are 11 clients who are billed in full.    To view the report, see Sample Report     #7.



First, select "Set Date Limits" from the "Subset List" menu.    Set the Start Date to "10/01/91" and 
the End Date to "10/15/91.    Select "Set"; then "OK".    Then get a list of all the "Clients-Full 
Billing" by using "People - Any Check" from the "Subset List" menu. There should be 11 names on
the list.    Select "Summary Reports" from the "Reports" menu; then select "Activity for Date 
Range".    The report will be printed automatically, unless you select "Cancel" on the print button 
that appears in the center of your screen, before or during the printing process.    Summary 
reports are continous, and not one page for each individual.    Unlike the detail report,    people on 
you subset list that do not have activity during the date range are not omitted.    Their name and 
title (suffix) is printed, along with the message "No Activity".    Don't forget to restore the 
database before proceeding.



Select "People - Any Check" from "Subset List" menu; then select "Name List for Subset" from the
"Summary Reports" under "Reports" option.



There are five:    Bloodsworth, Hafftone, Vorhees, Wheeler, and Wright.    To view the final report, 
see "Sample Report    #8.



First, get the name of all the subcontractors.    Select "People - Any Check" from the "Subset List 
menu.    Put an "X" in the Yes box next to "Independent Contractors", and select "OK".    This will 
yield a list of five names.    Select "Summary Reports" from the "Reports" menu.    Now select 
"People in Subset".    The report will be printed automatically, unless you select "Cancel" on the 
print button that appears in the center of your screen, before or during the printing process.    
Summary reports are continous, and not one page for each individual.      Don't forget to restore 
the database before proceeding.



Select "Database Statistics" from "Summary Reports" under "Reports" menu.



To view the final report, see Sample Report #9.



This report is a quantitative check on the compositon of your database, and the activity in the 
database.    Select "Summary Reports" from the "Reports" menu.    Then, select "Database 
Statistics.    The report will be printed automatically, unless you select "Cancel" on the print 
button that appears in the center of your screen, before or during the printing process.    This is a 
one-page report.    You will notice that the number of people category checks, and the number of 
event category checks may not add up to the total number of people in your database.    This is 
because, in both cases, it is possible to check more than one category for each person's file.      
Don't forget to restore the database before proceeding.



Select "Labels - 2up" from "Labels" reports under "Reports" menu.



To view the labels, see Sample Report    #9.



Make sure that you restore your database to the full "50 of 50 Records Selected".    Select 
"Labels" from the "Reports" menu.    Then select "Labels - 2Up".    The report will be printed 
automatically, unless you select "Cancel" on the print button that appears in the center of your 
screen, before or during the printing process. 





Quick Start Questions - Category #5 - Creative Searches and Reports

Find out if anyone in your database has no "People Category" checks.

Make a special "Subset", but make it show only the first two people your screen.

Use the "Label" report function to make labels for the two people you chose in Item #44.    Use 
the 3-UP format.

"Some time in October", we finished a loan package for someone, and had to revise the package 
that same day, because of price increases.    Who was it, and what date did it occur?

Print mailing labels for all partial - bill clients only. Print them 1-UP.

List the companies that the following people are associated with: Carter, Downes, and Jones.

On what date did we complete our project with SUBURBAN SUNLAMPS?

The following companies are seasonal businesses;    our contacts with them spend six months of 
the year in another city.    Change their primary address to their 2nd addresses: ADAMS APPLES, 
BUTLER BONDING, DAKOTA DOZERS, NATURAL             NUTRITION,and PHILLIPS & BARTON, P.A..  



 



Find out if anyone in your database has no "People Category" checks.

Hint
Answer
Procedure



"Subset List"; "People - All Checks"; mark each category "No".



Yes, it's William Whitehall.



The "People" checks are important for creating subset lists of people that have something, or 
multiple things, in common.    They are also important for selective mailing lists, committee lists, 
and more.    They can also answer unique questions about your people base;    as unique as you 
can think of.    Imagine having two categories:    Board of Director, and Contributor.    Who wouldn't
want to ask the question, "Which of my Board is a contributor?"    Better yet, "Which of my Board 
members is NOT a contributor?"    Select "People - All Checks", and put an "X" in the No box of 
each and every category to find Mr. Whitehall.    And then ask yourself. "Why didn't they classify 
him?"



Make a special "Subset", but make it show only the first two people your screen.

Hint
Answer
Procedure



"Update" the two people, and check the [Open] box. Then do a "People - Any Check"                
subset list based on the [Open] selection.



Adams and Andrews.



Highlight Andrew Adams (in the people list) and double click his name.    When the Update screen 
appears, notice that the last two categories are marked [open].    Put an "X" in the last box, and 
select "OK".    Now do the same for Alicia Andrews.    You have specially marked these two to 
create a subset list of only the two of them.    Select "People - Any Check" from the "Subset List" 
menu, and put an "X" in the Yes box next to the same last category ([open]); Select "OK".    PMS, 
at your special instructions, has set the two people aside in a subset list.    Double click Adams, 
and select the Yes box next to that last category.    The "X" will disappear; then select "OK".    Do 
the same for Andrews, to restore the data to the way it was before this exercise.    Do not restore 
to full database until after you do the next question.



Use the "Label" report function to make labels for the two people you chose in Item 
#44. Use the 3-UP format.

Hint
Answer
Procedure



Just select the label format.



Just select the label format.



Since you did not restore the full database, simply select "Labels" from the "Reports" menu, and 
then select "Labels 3-UP".    Labels will print automatically, in an industry standard format.



"Some time in October", we finished a loan package for someone, and had to revise 
the package that same day, because of price increases. Who was it, and what date did 
it occur?

Hint
Answer
Procedure



Set date limits for October; make a subset list for "Loan Package Done", and choose  "Show
Only Selected Events".    Look through the event record box for the answer.



It was Thomas Trump, on October 8. 1991.



Whoever is asked such a question would like to start vacation early!    But, PMS can handle this 
one!    You have two clues:    it was in October, and a loan package was done.    Select "Set Date 
Limits" from the "Subset List" menu.    Set the Start Date to read "10/01/91" and the End Date to 
read "10/31/91"; select "OK".    That handles the "October" clue.    Now select "Event - Any Check" 
from the "Subset List" menu.    Put an "X" in the Yes box next to "Loan Package Done"; select 
"OK".    This will give you a list of three people.    We can narrow it done even further.    Select 
"Show Only Selected Events" from the "Options" menu.    PMS had given you a list of people who 
met the criteria, but gave you all the records for those people.    The last selection you made 
(Show Only Selected Events) has reduced the list of events to the "Loan Package Done" criteria.    
Now you have three people; each with only one event.    Double click each person's event, and 
inspect the Update screen for the answer.    It's the last one on the list, but then again, it's a short 
list.



Print mailing labels for all partial - bill clients only. Print them 1-UP.

Hint
Answer
Procedure



Reduce the people list to those you want, and print the labels.



Reduce the people list to those you want, and print the labels.



You almost never want to mail to EVERYBODY.    You don't have to.    Select "People - Any Check" 
from the "Subset List' menu.    Then put an "X' in the Yes box next to "Client-Partial Bill"; select 
"OK".    This will yield a list of four people.    Select "Labels" from the "Reports" menu.    Select 
"Labels - 1UP", and PMS will print your four labels; one in each of four rows.



List the companies that the following people are associated with: Carter, Downes, and 
Jones.

Hint
Answer
Procedure



Find each name and double click it.



CATHY'S CANDIES, DAKOTA DOZERS, AND JUST JONES JALOPIES.



This part of the exercise is rather like "reverse training".    You've learned to use the "Display 
Company" option, but you can't use it for this question.    When you use "Display Company", PMS 
will reload your people list .    It does so to give you a list in alphabetical order; so you can find 
companies by name by normal means.    That doesn't mean that company names are not 
important.    And, you need them at your fingertips.    You have them close by with PMS.    Just find
each name in the people list, and double click the name (remember, you can also highlight the 
name and select the "Update" button).    Not only do you have the company name handy, you 
have the address(es), all phone numbers, and people categories chosen for the individual.



On what date did we complete our project with SUBURBAN SUNLAMPS?

Hint
Answer
Procedure



Use "Event - Any Check" and "Show Selected Events Only".



June 18, 1991



Perhaps you recognize the question; it was asked previously as Question #10.    The method we 
are going to use here will give you more power for larger databases.    Select "Event - Any Check" 
from the "Subset List" menu.    Put an "X" in the Yes box next to "Project Completed", and select 
"OK".    This will give you a list of 12 people that have completed projects.    Even before you look 
up SUBURBAN SUNLAMPS, do the following:    Select "Show Only Selected Events" from the 
"Options" menu.    Go back to the "Options" menu, and select "Display Company".    No need to 
scroll down the list, as SUBURBAN SUNLAMPS is on the screen.    Highlight SUBURBAN, and there's
only one event in the event box at the bottom of the screen.    It's the one that matches your 
search criteria.    For practice, select the drop box just under the "Help" menu that says "Events - 
Any Check".    That will remind you that your search criteria was, in fact, "Project Completed".    
Now, you may double click SUBURBAN if you want to, but you probably know what's in there 
already.    To restore your full database, you need to undo the "Company Name", "Show Only 
Selected Event" and "Restore Full List".



The following companies are seasonal businesses;    our contacts with them spend six 
months of the year in another city.    Change their primary address to their 2nd 
addresses:    ADAMS APPLES, BUTLER BONDING, DAKOTA DOZERS, NATURAL 
NUTRITION,and PHILLIPS & BARTON, P.A..

Hint
Answer
Procedure



Select "Display Company", find them on the people list, double click them and "Switch Address" 
on each.    (No hint on how to do the labels).



Andrew A. Adams Bonnie B. Butler Donald D. Downes
3512 Montrose Lane 163 Sunrise Court 1212 Fairleigh Ave
San Diego, CA 65123 Ocean City, MD    21842 Peco, TX    63216

Nicholas N. Nero Peter P. Phillips
15 Dockside Lane 985 Spedden Rd.
Lawton, PA    50633 Bangor, ME    98001



Select "Display Company" from the "Options" menu.    Highlight "Adams Apples" in the people list,
and double click on the name.    On the Update screen, select "Switch Addresses".    While in that 
screen, put an "X" by the bottom checkbox that says "Open", so we can find this person when we 
go to print the labels.    Select "OK".    Next, find "BUTLER BONDING" in the people list, and double 
click on that name.    One the Update screen, select "Switch Addresses".    While in that screen, 
put an "X" in the Yes box next to the bottom checkbox that says "Open", so we can find this 
person when we go to print the labels.    Repeat this process for the other three companies.    Now,
to print the labels, select "People - Any Check" from the "Subset List" menu.    Put an "X" in the 
same Yes box you used for the five people, and select "OK".    This will yield a subset list of the 
five companies.    Select "Labels" from the "Reports" menu, and then select "Labels    -3 Up".    The 
labels will print automatically, unless you select "Cancel" for the printing task when given 
opportunity.    Now I am going to ask you to "undo" the exercise you just completed; so the next 
time "QUICK START" is used, it won't be confusing to the person doing the exercise.    Double click 
each name on the people list, select "Switch Addresses" again, and re-select the Yes box next to 
the "Open" category, so that the "X" disappears.    Don't forget to restore the full database, and to
toggle the "Display Company" to off.
If you had entered the company name in the "Company Name" field in the 2nd address, the 
labels would have contained the company names, as well as the individuals' names.



CATEGORY #6 - ABOUT INDIVIDUAL PEOPLE IN THE DATABASE:

What is the total amount (balance) for Catherine Carter/CATHY'S CANDIES?

What is the amount balance of all of her events?

What events caused the balance, and when did they occur?

What fee was charged to Thomas Trump for our services in packaging the loan for his equipment?

How much of Mr. Trump's fee has been paid to-date?

When was Mr. Trump's fee paid?

What is the status of Mr. Irving's account activity?

SUBURBAN SUNLAMPS hired Quick Start to privide projected cash flows. Most of the figures were 
compiled by a CPA named Righter.    How much did Righter's services cost     Quick Start?  

When did Sheldon Smith pay his retainer, and how much did he pay?

How much was NIGHT NOTIONS' final payment, and how was it paid?



What is the total amount (balance) for Catherine Carter/CATHY'S CANDIES?

Hint
Answer
Procedure



Try the amount boxes below the people list.



$1250.00 (shows as a negative number).



Make sure you have selected "Display Amounts" from the "Options" menu.    Now you will see four
"amount boxes" below the people list, and above the event list.    Highlight Catherine Carter in the
people list. The "Amount-Selected Person" box has the answer in it.    The number shows as a 
negative, because that's the way QUICK START COMPANY uses PMS.    When she pays the 
$1250.00, it will be entered as a positive amount, and her balance will be zero.    You could have 
double clicked Ms. Carter's name in the people list, and inspected her Update screen.    (When you
do this, you have the option to manually enter an amount different than the present one.    You 
will offset PMS's ability to keep a balance in the amount totals of "person" and "events" if you 
change the "person" total.    The best way to adjust an account is to add an event with the 
adjustment, and explain the adjustment in the event comments box.)    



What is the amount balance of all of her events?

Hint
Answer
Procedure



Try the same location; different amount box.



$1250.00.



This time look in the amount box titled "Total Amount-Event List".    Since you have Ms. Carter 
selected, it is her event list total that is in the box.    It matches her "Amount-Selected Person".    
This is not always the case;    there are two cases where the totals may not agree.    The first 
derives from your ability to manually change or enter the "Amount-Selected Person" on a 
person's Update screen.    Depending on your needs for the "amount" feature of PMS, you may 
wish to do this.    The second case where the totals may not agree is when you have selected 
"Show Only Selected Events" from the "Options" menu.    You may be looking at part of a person's 
events (one month, for example), and the "Total Amount-Event List" will be the total for less than 
all of that person's events.    This will not affect the "Amount-Selected Person", which is designed 
to show the balance of all events (unless you change it manually as described above).



What events caused the balance, and when did they occur?

Hint
Answer
Procedure



Search event by event to see the complete picture.



A $3250.00 fee recorded on 9/9/91, and a payment of $2000.00 on 10/6/91.



Locate the "Amount-Selected Event" box below the people list.    Highlight the bottom event for 
Ms. Carter (9/5/91), and see the amount in that box.    Since there was no "funds" activity on that 
date, the "Amount-Selected Event" is zero.    Select the next event in time (9/9/91).    The box now 
shows -$3250.00; a negative entry meaning her fee was set, and that QUICK START COMPANY 
expects to receive that amount at some time in the future.    Click on the next event (9/20/91) to 
see a zero amount.    Click on the next event (10/06/91), and you will see the amount of 
$2000.00, representing a payment by Ms. Carter.    Click on the rest of the events to be sure, but 
you now have the answer you were looking for.    If you wanted specific information on any 
specific event of Ms. Carter, you could have double clicked on it to see the whole event file.    
(When you get more familiar with PMS, there is a better way to answer such questions; 
especially if your database is much larger.    Knowing that QUICK START uses the "Funds" event 
checkbox, and Ms. Carter must certainly have the "money" events checked, you could create a 
subset list of "Event-Any Check", and put an "X" in the Yes box next to "Funds".    Then, you would 
select "Show Only Selected Events" from the "Options" menu, and highlight Ms. Carter's name in 
the people list.    Only two events would show; the two you were looking for.)



What fee was charged to Thomas Trump for our services in packaging the loan for his 
equipment?

Hint
Answer
Procedure



Check his event list.



$2750.00



Highlight any name in the people list, and type a "T" from your keyboard.    Highlight Mr. Trump's 
name in the people list, and look at his event list.    The amount boxes aren't much help in 
answering this question, but the answer is at your fingertips.    Since you are getting familiar with 
QUICK START COMPANY, you probably noticed the keyword in the 10/01/91 event title: "signed".    
That means the contract was signed; and that is when they would enter his fee.    Highlight that 
event and look in the "Amount-Selected Event" box.    The "-$2750" is in fact the value you are 
looking for.



How much of Mr. Trump's fee has been paid to-date?

Hint
Answer
Procedure



Either the events or the amount boxes will yield the answer.



$2750.00



Since Mr. Trump's "Amount-Selected Person" is zero, you could assume that he has paid in full.    
He has. 



When was Mr. Trump's fee paid?

Hint
Answer
Procedure



This time it is only answerable from the event list.



$1000.00 was paid on 10/8/91, and $1750.00 was paid on 10/24/91.



You may have done this to answer the previous question, but since you are still on the PMS    
"learning curve", highlight the 10/08/91 event to see the $1000 payment, and the 10/24/91 event
to see the $1750 final payment.



What is the status of Mr. Irving's account activity?

Hint
Answer
Procedure



Look at his event list, and try to figure out what has happened.



His company's outstanding balance is $200.00, which was due about four months ago. Reminders
were sent monthly, and the account is ready to be sent to a lawyer. 



Find Mr. Irvings in the people list and highlight him.    Look in the event list at the 7/15/91 event 
title.    Since the subsequent events all appear to be reminders, this event appears to be the last 
substantial contact with Mr. Irvings.    And, notice his amount totals.    He owes the company 
$200.00, which apparently is overdue.    Double click the 7/15/91 event to inspect the event 
record.    You will see that the project is complete, and on that date he paid the sum of $500.00.    
If you wish to search a little further, you will find that his fee was $750.00.    Apparently, he 
brought a check for less than the full fee, and is neglecting to pay the balance.    Looking a little 
more closely at Mr. Irving's event list, you will find a unique feature of PMS.    The 8/15/91 event 
title originally read "Send reminder if payment is not received.", and then updated to add the 
word "(sent)".    When he did not pay the full amount on 7/15, the 8/15 event was added as a 
future event to remind the system operator to send out the reminder.    When that was done, the 
update was recorded to show that the reminder was actually sent.    PMS will allow you to enter 
future dates for any person; just add an event, and manually change the date before you select 
"OK" to enter the event into the database.    You may also use the checkboxes, record an amount 
(such as a late fee), and record text comments about the future event.    You may search for the 
future event by either date, or checkbox; or both.    The best answer to this question about the 
status of activity on Mr. Irving's account is "insufficient activity".    The most recent reminder has 
not even been sent out yet.    A small business like QUICK START COMPANY needs to set a rigid 
policy of honest collection efforts if it plans to survive!



SUBURBAN SUNLAMPS hired Quick Start to privide projected cash flows. Most of the 
figures were compiled by a CPA named Righter.    How much did Righter's services cost 
Quick Start?

Hint
Answer
Procedure



QUICK START'S policy is to record amounts paid to subcontractors in client's files, using the 
"Funds" checkbox, but not to record the amounts in the event "Amount" box.



$500.00.



Select "Display Company" from the "Options" menu.    Highlight any name in the people list, and 
type an "S" from your keyboard.    Continue down the people list until you highlight the company's
name.    (With names that approach the next alphabetical character, in this case the "T", you 
might try typing a "T" instead of an "S".    That way, you won't have to scroll down the list at all.)   
Look at SUBURBAN SUNLAMPS' event list.    Both "projections" and "Righter" appear in the 6/15/91
event title.    Double click that event and read the event comments box to find the amount paid to
him.    It was $500.00.    Notice that the "Funds" checkbox was used, but that the "Amount" box 
was not used.    An entry of this amount might cause considerable confusion in QUICK START 
COMPANY'S amounts; and the event total would be increased by an amount which is already 
included in the client's fee.    Again, although you could find this answer easily, you would go 
about it differently with a larger database with many events.    Select "Event-All Checks", and 
choose "Projected Cash Flow" and "Funds".    Next, select "Show Only Selected Events" from the 
"Options" menu, and then highlight SUBURBAN SUNLAMPS in the people list.    The event list will 
be shortened to include only those that have to do with "Projected Cash Flow" or "Funds".    If you 
click through the events, two will have values in the "Amount-Selected Event" box; these were 
either fees or payments.    The event with no value is the one that QUICK START has used to 
record the independent contractor expenditure.    Double click the event to see the amount.    
PMS did not find the exact match; it found the people that matched the event criteria.    PMS will
always consider the people more important than events, and sometimes give you more 
information than you need.    How you enter the information will be your key to maximizing PMS's
performance.



When did Sheldon Smith pay his retainer, and how much did he pay?

Hint
Answer
Procedure



It's the earliest event with a positive amount for the event.



On September 15, 1991 (2:15 pm), he paid $1000.00.



Let's do it the long way again; your database may not be as convenient to work with.    Because 
you are a graduate of the Section I Exercise, you are no longer reminded to restore to full 
database, reset "Display Company", etc.. (That was your final reminder.)    Select "Event-Any 
Check" and choose "Funds" as your selection criteria.    Select "Show Only Selected Events".    Find
and highlight Sheldon Smith in the people list.    Click each event from the bottom up (that's how 
the events occurred, and it's less confusing).    Watch the "Amount-Selected Event" box as you 
click each event; looking for a positve value (representing a payment).    The first client payment 
is usually the retainer, so try the 9/15/91 event, by double clicking on it.    Yes, the amount is 
described in the event comments box as being the retainer.    What about the 8/27/91 event that 
showed no amount in the "Amount-Selected Event"?    Check the event record to see a payment 
to Smith's accountant of $250.00 for consulting fees.    Check the rest of the events (each one has
to do with "Funds").    The 9/27/91 event shows a zero for the event amount also.    Double click it 
to see a $550.00 payment to Creighton for the appraisal.



How much was NIGHT NOTIONS' final payment, and how was it paid?

Hint
Answer
Procedure



Find the event with the $300.00 payment.



Final payment was $300.00, and it was paid at settlement of his loan.



Use the "Funds" event subset criteria method again.    Find and highlight NIGHT NOTIONS in the 
people list (you will have to use "Display Company").    Look at the event list.    There are six 
events.    Use the "Show Only Selected Events" feature.    The list is reduced to three events.    
According to your search criteria, they all have to do with "Funds".    Again, as it pays to be 
familiar with the crucial events about your clients; click each event and find the final $300.00 
payment.    It will be the one that shows a $300.00 value in the "Amount-Selected Event" box.    
Double click on the 8/29/91 event and inspect the event record.    The record is checked "Project 
Complete", the amount of $300.00 was paid, and the client's "Total-Person Selected" is zero.    The
amount was paid at the settlement of his loan.    (You could have chosen a subset list using 
"Project Complete", and the only event that would show while you were using "Show Only 
Selected Events" would be the right event.    That would only work, however, when the final 
payment was made immediately upon the completion of the project, and recorded in the same 
event.)



CATEGORY #7 - ABOUT GROUPS (SUBSET LISTS)

Of all contracts completed, how much shows as the uncollected balance?

Of the uncollected balance in the previous Question, who owes it?

What is the balance outstanding on all clients who are "partial-billing" clients?

What is the balance outstanding of all people who are "full-billing" clients?

List the "full-billing" clients with amounts outstanding, and the amounts.



Of all contracts completed, how much shows as the uncollected balance?

Hint
Answer
Procedure



The answer will show in the "Total Amount-People List" box.



$450.00



Design a subset list of all those who are checked "Project Complete".    Select "Event - Any Check"
from the "Subset List" menu, and put an "X" in the Yes box next to "Project Complete".    PMS will 
return a list of those people.    Read the "Total Amount-People List" box below the people list.    The
answer is "-$450.00"; expressed as a negative because it has not been offset by a positive 
payment (QUICK START COMPANY's procedure).    Do not restore to full database yet.



Of the uncollected balance in previous Question, who owes it?

Hint
Answer
Procedure



The answer will show in the "Amount Selected Person" boxes.



Ira Irvings owes $200.00; Kathy Kraus owes $250.00.



This type of question is usually asked by someone familiar with scanning reports, but a report 
may not always be desired.    To find the people on this subset list who have outstanding 
balances, highlight each person in the people list; looking at the "Amount-Selected Person" box 
after each change in name highlighted.    It won't take long to see the $450.00 answer.



What is the balance outstanding on all clients who are "partial-billing" clients?

Hint
Answer
Procedure



The answer is in the "Total Amount-People List" box.



$200.00.



Design a subset list of all "Client-Partial bill" people by selecting "People - Any Check" from the 
"Subset List" menu.    Read the amount in the "Total Amount-People List" box below the people 
list.    Your answer is there.



What is the balance outstanding of all people who are "full-billing" clients?

Hint
Answer
Procedure



The answer is in the "Total Amount-People List" box.



$4,000.00



In the Section I Exercise, you were asked to "restore to full database" after each question.    If you 
did this after the previous question, go back and process the answer again.    This time, without 
restoring the full database, select "People-Any Check" from the "Subset List" menu, and select 
"Client-Full billing"; then "OK".    PMS does not need to restore the full database to assemble a 
new subset list (we only did that in Section I to enhance your familiarization with the process).    
You should have 11 people in the list now; each one of them is a "Client-Full billing" person.    The 
answer of $4000.00 is now displayed in the "Total Amount-People List" box below the people list.   
Again, do not restore to full database yet.



List the "full-billing" clients with amounts outstanding, and the amounts.

Hint
Answer
Procedure



The answer is found in the "Total Amount-Person Selected" boxes.



Carter: $1250.00; Downes:    $1750.00; Kraus:    $250.00; Otis:    $750.00.



Again, we are really looking a report function.    Follow the same procedure used in the previous 
question; using the subset list of "Client-Full billing" people to find those with outstanding 
balances.    They will add up to $4000.00, but this time you probably had to write the balances 
down on a sheet of paper to keep track of them.    If this type of question will be asked frequently 
with your use of PMS, plan on using reports to provide fast, hard-copy information.    Reports with
"amount" information are the subject matter of the next Category of questions.    A    creative way 
to have PMS give you lists of people with outstanding balances will be discussed in the next 
category.



CATEGORY #8 - INFORMATION THROUGH REPORTS

Irvings has been a problem with regard to his overdue account.    How may you best prepare 
documentation to seek legal counsel?    Counsel will need amounts.

We are studying our cash flow procedures, both current and projected. List all activity that 
occurred in the second half of October, 1991, in detail, for all persons or firms for whom we have 
done both.    Include amounts, if there are any.

Our Vice-President senses a problem in our relations with Mr. Trump. Prepare a detailed report 
showing all there is to know about our last contact with his firm.

Prepare a report to show the amount activity for any person or company for whom we have 
prepared a market study.

List the most recent activity for all persons or companies whose projects are now completed.    
Show the amount information.

Prepare a brief summary of all activity with our wholesale firm clients for the third quarter of 
1991.    Show amounts.

22. Determine the outstanding balances of all people with whom we have signed contracts.

Prepare a report to show the statistical overview of our company's clients and contacts, with a 
total amount for all people in the database, and a total amount for all events.

We have a need for a list of all clients, and their outstanding balances, for a bank meeting. We 
want to avoid using the terminology "Full billing" and "Partial bill", as we feel that does not 
pertain to the purpose of our meeting.    Can you print out the standard report, but change the 
headings?

Print labels (1 - Up) for all "Independent Contractors"; print them in zip code order.



Irvings has been a problem with regard to his overdue account.    How may you best 
prepare documentation to seek legal counsel?    Counsel will need amounts. 

Hint
Answer
Procedure



Use the "Detail History(Person)" report.



The most information you can give is shown in Report #13, at the back of this exercise (only the 
first page is shown).



Attornies want all the information they can get, in order to minimize their research, and increase 
their capability to serve you.    The Detail History Reports are the ones that give the most 
information.    Make sure Mr. Irvings is in the people list (he is not, because he is not a "Client-Full 
billing" person.    Either design a subset list of "Client-Partial bill", or restore the full database, 
using the option under the "Subset List" menu.)    Highlight his name, select "Detail Reports" from 
the "Reports" menu; then "Detail History(Person)".    If you were working with PMS without using 
the "Display Amounts" option (found under the "Options" menu), the report would not normally 
show the "amount" information.    "Amount" information must be shown on the main PMS screen 
to be automatically included in reports.    There are two ways to get amounts on reports; select 
the "Display Amounts" feature, or select "Customize Reports" from the "Options" menu.    When 
you select "Customize Reports", you will have the choice of showing, or not showing, amounts on 
the reports.    (More about customizing reports will follow.)

Since this is the first report you have printed that shows value amounts on it, take a 
minute to look at how and where the numbers show.    To the right of the name and address, and 
to the right of the telephone numbers listing, is an amount that shows in bold print.    This is the 
"Total Amount-Person".    This will be the "outstanding balance" of the person the report was 
prepared about, if you are using the same methodology as the QUICK START COMPANY.    A 
negative amount would mean they have an outstanding balance the company expects to collect.  
A positivie amount would indicate an overpayment, or more funds received than were entered as 
negative amounts on event records.    Next, notice that each event has a number to the right of it 
(not in bold print).    This is the amount that was entered for that event in the "Amount" box at the
bottom right of the Add/Update Event screen.    If a zero shows, no number was entered for the 
event.    Finally, the last line reads "Total Events Amount".    This is the mathematical total of the 
amounts for all events listed in the report.    If all the events are listed in the report (they are in 
the "Detail History" reports), the number should agree with the one to the right of the name and 
address (unless you manually changed it using the Add/Update Person screen).



We are studying our cash flow procedures, both current and projected.    List all 
activity that occurred in the second half of October, 1991, in detail, for all persons or 
firms for whom we have done both.    Include amounts, if there are any.

Hint
Answer
Procedure



Use the "Activity for Date Range" detail report.



See Report #14, at the back of this exercise.



You must follow this procedure carefully to yield the same report that is listed as the answer.    If 
you "did your own thing" after looking at the HINT, PMS may have asked you if you wanted to 
print 7 reports.    If you follow this procedure, you will only get a report for Nicholas Nero.    The 
reason for this will be covered later in this exercise.    Select "Set Date Limits" from the "Subset 
List" menu, set the "Start Date" to read "10/15/91" and the "End Date" to read "10/31/91".    Next,
design a subset list by using "Event-All Checks" from the "Subset List" menu, and put an "X" in 
the Yes boxes of both "Projected Cash Flows and "Current Cash Flows".    PMS will return a list of 
one person: Mr. Nicholas Nero.    He is the only person who had events related to both project and 
current cash flows during the time period stated.    Select "Activity for Date Range" from "Detail 
Reports" under the "Reports" menu.    The one-page report will be the true answer to the 
question.



Our Vice-President senses a problem in our relations with Mr. Trump. Prepare a 
detailed report showing all there is to know about our last contact with his firm.

Hint
Answer
Procedure



Use the "Last Activity" detail report.



See Report #15 at the back of this exercise.



The goal here is not difficult:    you want a "Last Activity" report from the "Detail Reports" 
submenu of the "Reports" menu.    And, you need the "amount" data to be printed on the report, 
because you want to know "all there is to know".    But, all detail reports are one page per person,
and you don't want to print multiple reports to get the information; it takes time and paper.    Can 
you think of a way to isolate Mr. Trump's name?    Find him in the people list, and double click his 
name.    You will find that he is both "Client-Full bill" and "Service Business".    If you design a 
subset list based on "People-All Checks", selecting both of those categories, PMS would return a 
list of four people who match that criteria.    You may choose the report desired, and "Cancel" the 
first three reports when the choice is given on your screen; yielding the one report.    Or, you 
could double click Mr. Trump's name, and put an "X" in the last "Open" category.    Then, using 
"People-Any Check", you could design a subset list of one:    Mr. Thomas Trump.    Choose one of 
these methods, and print the desired report.    If you choose the use of the "Open" category, don't
forget to double click his name again and reselect the "Open" box you checked.    The "X" will be 
removed, and his file restored.    Now, look at the report.    You see from the amount information 
that his account is paid in full, even though you are only showing the last activity contact with 
him.    Because you chose a detail report, there are event comments included.    Read them.    Do 
you think John should have stayed at the settlement after he got the company's payment?



Prepare a report to show the amount activity for any person or company for whom we 
have prepared a market study.    

Hint
Answer
Procedure



Use the "Activity Summary" report.



See Report #16 at the back of this exercise.



Design a subset list of all people for whom we have prepared a market study by using the "Event-
Any Check" feature under the "Subset List" menu.    Select "Market Study Done".    Choose the 
"Reports" menu; then "Summary Reports", then "Activity Summary".    The report you chose will 
not have names, addresses, phone numbers, people comments, or event comments.    It will have
each event listed, and will show the amounts (because you are working with the "Show Amounts"
feature currently selected).    Again, to familiarize yourself with how the amounts appear on the 
various reports, spend a few minutes examining the value amounts on the report.    (If PMS 
returns you a list with "0" people on it, you may be sure that's what you asked for.    Two 
questions ago, you used the "Set Date Limits" feature, but did not "Clear" the date limits.    The 
"error" did not show in the last question, because "Last Activity" reports disregard the date limits;
they show the last activity only; not the last activity in the date range.    Clear the date range, 
using the "Set Date Limits" function under the "Subset List" menu:    select "Clear" and then "OK". 
Now try the search again.    The susbet list is a list of four people.)



List the most recent activity for all persons or companies whose projects are now 
completed. Show the amount information.

Hint
Answer
Procedure



Use the "Last Activity"    summary report .



The report for your subset list of 12 people is Report #17.



Design your subset list by selecting "Event-Any Check" from the "Subset List" menu, and 
checking "Project Completed".    PMS will return a subset of 12 people that match the selection 
criteria.    Since the question asks for the "most recent activity", our selection of report will be 
"Last Activity".    Since detail is not requested, our selection will also be a "summary" report.    
Select "Summary Reports" from the "Reports" menu, and select "Last Activity".    Examine 
Report#17 at the back of this exercise to be sure that your report matches.    

If you decided to select the "Display Company" feature after reading thequestion, your 
report would display the company names, instead of the individuals' names.



Prepare a brief summary of all activity with our wholesale firm clients for the third 
quarter of 1991. Show amounts.

Hint
Answer
Procedure



Use the "Activity for Date Range" summary report.



Six are in the subset.    See Report #18 at the back of this exercise.



Examine the question for the clues to answer the question before reading this procedure.      You 
are looking for activity that occurred in the third quarter; select "Set Date Limits" from the 
"Subset List" menu, and set the "Start Date" to read "07/01/91".    Set the "End Date" to read 
"09/30/91".    Select "Set"; then "OK".    Get a subset list of all clients that are checked "Wholesale 
Firm", by using "People-Any Check" under the "Subset List" menu. If you designed the subset list 
before setting the date, the same people would be on the subset list.    This is because PMS does 
not regard date limits when selecting with "People Category" criteria.    Since setting the date 
range will affect your subset list results when using "Event Category" criteria, it's a good idea to 
always set the date range first.    Now, for the report.    One of the clues is "summary".    The 
proper choice for the report is to select "Summary Reports" from the "Reports" menu; then 
"Activity for Date Range".    But, before you do this, highlight Mr. Shapiro, the last name on your 
people list.    Look at his activities; some occurred outside of the date range for which you are 
reporting.    To limit the information on your screen, you must select "Show Only Selected Events" 
from the "Options" menu.    A "date range" report, however, does not regard the "Show Selected 
Events" feature:    it prints the activities within the date range for the designed subset list.    Print 
the report (without selecting "Show Only Selected Events").    Look at your report to see that only 
events occurring in the third quarter are listed.    Also notice the totals at the end of the report.    
For the first time in this exercise, the totals do not agree.    Can you determine why?    (Although 
the people have "certain" totals, manipulation of which events are shown on reports will yield 
different groups of events; therefore different totals.)



Determine the outstanding balances of all people with whom we have signed 
contracts.

Hint
Answer
Procedure



The answer is in the "Total Amount-People List" box.



The total amount outstanding for these people is $4200.00. See Report #19.



Design your subset list by selecting "People-Any Event" from the "Subset List" menu, and putting 
an "X" in the Yes box next to "Contract Signed".    PMS will return a list of 15 people.    Select 
"Summary Reports" from the "Reports" menu, and select "People In Subset".    Because you are 
working with the "Display Amounts" feature enabled, the report will show their balances next to 
their names.    People with zero balances will be listed also.    This report is Report #19.    (If you 
got a subset list of only eight people, you are still working with the "Set Date Limits" feature 
enabled, and got a list of all people that signed contracts in the third quarter only.    Your total will 
be off by $2000.00)



Prepare a report to show the statistical overview of our company's clients and 
contacts, with a total amount for all people in the database, and a total amount for all 
events.

Hint
Answer
Procedure



Use the "Database Statistics" report.



See Report #20, at the back of this exercise.



You have probably figured out QUICK START's methodology by now.    Each question dealing with 
reports has progressively caused you to select the next report in the "Reports" menu.    The 
"Detail History (Subset)" report was omitted, because it is the same as "Detail History (Person)"; 
but for a series of reports of a subset list.    Labels will be omitted in Section II, because the use of 
value amounts do not affect label printouts.    The only exception is found in Question 26:    this 
series of single labels is printed in zip code order, and shows the use of an extra line in the labels 
(the extra address line).    Select "Summary Reports" from the "Reports" menu, and choose 
"Database Statistics".    Compare your report with Report #20, and notice the display of amount 
values.



We have a need for a list of all clients, and their outstanding balances, for a bank 
meeting.    We want to avoid using the terminology "Full billing" and "Partial bill", as 
we feel that does not pertain to the purpose of our meeting. Can you print out the 
standard report, but change the headings?

Hint
Answer
Procedure



Use the "Customize Reports" feature under the "Options" menu.



See Report #21 at the back of this exercise.



Select "People-Any Check" from the "Subset List" menu, and put an "X" in the Yes box next to 
both types of clients:    "Client-Full billing", and "Client-Partial bill".    PMS will return a list of all 
clients.    The "People in Subset" report is the correct format, but before you choose it, select 
"Customize Reports" from the "Options" menu.    Until you turn this feature off, a special screen 
will appear each time you select a report to be printed.    This screen is called the "Customize 
Report" screen, and is reproduced >>>>>>>>>>>>>>>>.    Now, choose "Summary Reports" 
from the "Reports" menu, and then choose "People In Subset".    When the "Customize Report" 
screen appears, position your cursor in the box titled "People In Subset Summary", and delete the
title.    Using your keyboard, type in "Current Client List".    Do not press "Enter", since that is the 
same as selecting "OK", and will cause you to exit the screen.    Position your cursor in the box 
titled "Selection by Event - Any of the following categories", and delete that text.    Type in 
"Showing Outstanding Balances".    Position your cursor in the last box, and delete the text that 
shows the two client types.    Enter no text in this box.    If you select "OK" at this point, you will 
print a report that is the same as Report #21.    But, before you do this, let's examine the rest of 
the screen.    

Find the "Include Amounts" box.    If you wish to change whether the amounts show or not,
that is to say to print contrary to the default procedure, you may change it by selecting this box.   
The box "toggles" on and off each time you select it.    When the "X" appears, the amounts will be 
included.    Below this box are two that customize the names that appear on the report.    If you 
check "Use Company Only", only the company name will appear in the report.    (If there is no 
company name, the individual's name will be used.)    If you select "Use Both Name and 
Company", both the individual contact's name and his company's name will appear in the report. 
The next two boxes will allow you to display the desired addresses on your reports.    The primary 
address is the default address.    If you choose the first box, "Use Second Address", the report(s) 
will bear the non-primary address instead. Or, you may choose the "Include both Addresses" box 
and include them both.    If the address boxes are "greyed", that is because the report you are 
about to print do not contain addresses.    Next find the "Save for future use" button.    If you 
select this feature, all future reports of this type (People in Subset Summary reports) will carry 
the same heading.    If you only edit part of the heading, only that part of the heading will be 
saved as changed.    What the screen looks like when you save it will be what future report 
headings will look like.    If you select the "Restore Defaults" button, the screen will show you the 
original headings.    The current report will print the default headings.    If you wish to return 
permanently to default headings, just "Save them for future use".    If you select "Cancel", the 
changes you saved are, in fact, saved.    But, the report will not be printed.    If you select "OK", 
regardless of whether you made changes in the heading or not, the report will print (with 
whatever changes you made in the heading).    

Now that you have examined the screen, select "OK" to print the report.    Because you did
not select "Save for future use", all future reports will bear the default headings.    That is, until 
you decide to make changes using the "Customize Report" feature.    You may use this feature for 
any of the nine basic reports; labels are unaffected by headings, and do not cause the screen to 
appear.    Before you proceed to the next question, reselect the "Customize Reports" feature to 
turn it off.



Print labels (1 - Up) for all "Independent Contractors"; print them in zip code order.

Hint
Answer
Procedure



Use one of the "Options" features.



See Report #22 at the back of this exercise.



Select "People - Any Check" from the "Subset List" menu, and put an "X" in the Yes box next to 
"Independent Contractor"; select "OK".    Select "Display Zip Codes" from the "Options" menu.    
PMS will diplay your people list in ascending zip code order, with only the last names.    Select 
"Labels" from the "Reports" menu; then select "Labels- 1 Up".    Review the printed labels to see 
that they are in ascending zip code order.    Also note the use of the extra "address" line you have 
seen on the Add/Update Person screen.    Notice that if there is no company name, the line for it 
will be omitted.    Compare your labels with Report #22.



CATEGORY #9 - CREATIVE USE OF PMS

Create a way to ask PMS for a list of people with outstanding balances.

Can you contrive subset lists and report output by the combination of "Set Date Limits" and the 
"Show Only Selected Events" features?



Create a way to ask PMS for a list of people with outstanding balances.

Procedure



Remember, we have stated that PMS is not designed to be an accounting system.    But, if you 
have limited types of transactions with people, you may not need a full accounting system for 
most of your administrative functions.    It is in this light that we urge you to be creative with 
PMS's resources.    In order to prepare you to use the program, this tutorial has taken you through
just about every menu item.    You should be able to use the system without spending much time 
in the manual.    As you grow more familiar with PMS, you will find that the normal functions and 
features will meet current needs in your organization that are not covered in the documentation.   
The following is an example:

Do not make this change in the QUICK START COMPANY database.    Just think it through.    
Suppose you allocated one of the "People Categories" to be named "Outstanding Balance".    We 
did something similar when we named one of the "Event Categories" as "Funds".    With a 
structure like this, you could have the answer to the question.    Every time you set up a negative 
amount in the "Funds" category, you would Update the person and put an "X" by the 
"Outstanding Balance" category.    At any give time, you could create a subset based on "People - 
Any Check" - "Outstanding Balance".    In order to make this fully functional, you would need to 
remove the "X" from "Outstanding Balance" of any account that made payment in full, or whose 
account was adjusted to "zero", (or met their pledge, or honored their committment, etc.).    There
are many such ideas that can be created using PMS's features and functions.    Once you see 
what the program can do, be creative in putting PMS to work for you and your organization.



Can you contrive subset lists and report output by the combination of "Set Date 
Limits" and the "Show Only Selected Events" features?

Procedure



Oh, Yes!    Let's go over the program logic one more time, and then we'll challenge you to 
experiment with some unique operations using these two features.    

When assembling a subset list, the "Set Date Limits" will not affect the selection of people
who qualify for the subset list, if the criteria is "People-Any Check" or "People-All Checks".    But 
when you use "Event-Any Event" or "Event -All Checks", PMS will only return the people who 
have events of your specified category that are in the date range.

When the events are displayed (in either case), all events are displayed; regardless of the 
date of the event.    When you select "Show Only Selected Events" with the date limits on, only 
the events occurring between the dates AND that match the event checkbox(es) of your selection
criteria will remain in each person's event list.    When you choose "Show Only Selected Events" 
with the date limits off, all events for the selection criteria category(ies) will be displayed.

When you print a report, only the events that show on the person's event list will be 
printed, unless you are selecting a "date range" report.    If you want all the events, not just those 
that are selection criteria, make sure "Show Only Selected Events" is not in operation.    That's the
basic program logic and operation.

Now, assuming a subset list based on events, does it make a difference whether you set 
the date range before you create the subset list or after?    It has to.    In the former case, all 
people with the event selected appear in the subset list; in the latter case, all may not.    Your 
reports are still meaningful.    If a selected person has no activity during the date range, the 
report will read "No Activity" after that person's name.    But, if he has an outstanding amount, 
and is not included in the report, your totals on the report will change.

Try the following exercise (if you choose).    If it's still morning; fill your coffee cup before 
you start.

BASIC PREMISE:    Examine the activity for all clients that have had loans approved; 
concentrating on the month of August.    Use a summary report.

1a. Create the subset list for clients that are checked "Loan Approved".    (This will be 
"People-Any Check"; "Loan Approved".)    Then, set the date range for 8/1/91-8/31/91.    Print an 
"Activity Summary" report.    

1b. Turn on the "Show Only Selected Events" feature.    Print the same report.    

1c.    Compare the two reports; then restore the full database.

2a. The date range is still set.    Create the subset list again, with the same criteria.    Print 
the same report.

2c. Turn off the "Show Only Selected Events" feature.

2d. Print the same report again.

3.      Compare reports "2c" and "2d".

4.      "Clear" the date limits.    Get the subset one more time.    Now set the date limits 
again.    This time, choose "Activity for Date Range" from the "Summary Reports", and print it.    
The result is probably what you wanted to answer the question.

The real confusion is created when the question is unclear.    The following questions will 
demand the respective reports you printed out:

1a.    List all the people with "Loan Approved', and list all their events.



1b.    List all the people with "Loan Approved", and list the event which shows the loan 
approval.

2a.    List all the people with "Loan Approved" in the month of August.    List the event 
which shows the loan approval.

2b.    List all the people with "Loan Approved" in the month of August, and list all their 
events.

The only effect date had on these four reports was to generate the subset.    If you wanted
all persons with "Loan Approved", you should not have set the date before generating the subset. 
The only effect "Show Only Selected Events" had on these reports was to limit the listing of 
events to those that were selection criteria - the specific event of "Loan Approved" that was used 
to generate the subset.

The report in 4. would answer the question, "Of all the people with a 'Loan Approved' 
event, list all events that occurred in August."    If you went one step further, and ran this report 
with "Show Only Selected Events" enabled, the only event that could show would be events in the
date range (a function of the report), and ones that were used as selection criteria (a function of 
"Show Only Selected Events")    That would be the "August" event of "Loan Approved" .

The other difference in these reports is the amount information.    The "Total for People 
Selected" amounts range from $0.00 to $2000.00; the "Total for Events Selected" amounts range 
from $0.00 to $2450.00.    

To avoid all this confusion, use the date range reports (detail or summary) when you want
to print information within a date range.    Use the "Set Date Limits" function when you want to 
limit your subset list to people with events that occurred within the date range.    Use "Show Only 
Selected Events" to find    and print information about the events that were your selection criteria.

The most important thing you can do to avoid confusion about PMS's many variables is to
be crystal clear about what information you want to show on your screen, and in your reports.    
You will get what you ask for; but you may need to learn to ask for what you want.


